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Product Basics
See these sections to learn about the basic features of your product.
Using the Control Panel
Product Parts Locations
The Power Off and Sleep Timers
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Using Google Cloud Print
Using the Mopria Print Service

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Using the LCD Screen
Adjusting Control Panel Position
Changing LCD Screen Language
Turning Off Control Panel Sounds
Turning Off Auto Selection Mode
Turning Off the Document Alert
Turning On Quiet Mode
Parent topic: Product Basics
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Control Panel Buttons and Lights

1 The power button and the power light
2 The home button
3 The LCD screen
4 The up and down arrow buttons (you can also scroll by swiping up and down on the LCD screen

with your finger)
5 The Output Tray button
6 The Back button
7 The Start button

Parent topic: Using the Control Panel
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Using the LCD Screen

1 Displays the screen name
2 Displays network status; tap the icons to check the current status
3 Tap the arrows to display other features or menus

To view a list of the icons and a description of their use, select Help > Icon List.
Parent topic: Using the Control Panel

Adjusting Control Panel Position
You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.
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Note: The control panel rises and the output tray slides out automatically when printing starts.

Parent topic: Using the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.

1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select Basic Setup.
4. Select Language.
5. Select a language.

6. Press the home button to exit.
Parent topic: Using the Control Panel

Turning Off Control Panel Sounds
You can turn off the sound heard when you press buttons on the control panel.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
4. Select Sound.
5. Select Button Press.
6. Select the Off setting.

7. Press the home button to exit.
Parent topic: Using the Control Panel

Turning Off Auto Selection Mode
Auto Selection Mode changes the menu options on the LCD screen automatically depending on the
action you perform. For instance, loading a memory card displays memory card-related menu options on
the screen. You can turn off this feature from the control panel.

1. Press the home button, if necessary.
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2. Select Setup.
3. Select Guide Functions.
4. Select Auto Selection Mode.
5. Turn off the desired options displayed on the screen.

6. Press the home button to exit.
Parent topic: Using the Control Panel

Turning Off the Document Alert
The Document Alert warns you that an original has been left on the scanner glass. You can turn off this
feature from the product's control panel.

1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select Guide Functions.

You see this screen:

4. Select Document Alert.
5. Select Off.
6. Press the home button to exit.
Parent topic: Using the Control Panel
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Turning On Quiet Mode
You can reduce the noise the product makes by turning on the Quiet Mode option.

Note: Turning on this setting may reduce print speed.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
4. Select Quiet Mode.
5. Select the On setting.

6. Press the home button to exit.
Parent topic: Using the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Top
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics
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Product Parts - Top

1 Rear paper feed slot cover
2 Paper support and extension
3 Rear paper feed slot
4 Edge guides
5 CD/DVD tray (shown removed and in storage position)
6 Document cover
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1 Document cover
2 Scanner glass
3 Memory card access light
4 Memory card slots
5 USB Type A port for external devices

Parent topic: Product Parts Locations
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Product Parts - Front

1 Control panel
2 Output tray
3 Cassette 1 (upper cassette)
4 Cassette 2 (lower cassette)
5 Front cover (attached to Cassette 2)
6 Cassette edge guides

Parent topic: Product Parts Locations
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Product Parts - Inside

1 Scanner unit
2 Print head/ink cartridge holder

Parent topic: Product Parts Locations

Product Parts - Back

1 AC inlet
2 Rear cover
3 LAN port
4 USB port
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Parent topic: Product Parts Locations

The Power Off and Sleep Timers
The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management, but increasing the time reduces the product's energy
efficiency.
Changing the Power Off Timer Setting From the Control Panel
Changing the Sleep Timer Setting From the Control Panel
Changing the Power and Sleep Timer Settings - Windows
Changing the Power and Sleep Timer Settings - OS X
Parent topic: Product Basics

Changing the Power Off Timer Setting From the Control Panel
You can use the product's control panel to change the time period before the printer turns off
automatically.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.

You see this screen:

4. Press the up or down arrow button to select Power Off Timer.
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You see this screen:

5. Press the up or down arrow button to select the length of time after which you want the product to
automatically turn off when it is not in use.

6. Press the home button to exit.
Parent topic: The Power Off and Sleep Timers

Changing the Sleep Timer Setting From the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
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You see this screen:

4. Press the up or down arrow button to select Sleep Timer.
You see this screen:

5. Press the up or down arrow button to select the time period you want before the product goes to
sleep.

6. Press the home button to exit.
Parent topic: The Power Off and Sleep Timers
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Changing the Power and Sleep Timer Settings - Windows
You can use the printer software to change the time period before the product enters sleep mode or
turns off automatically.
1. Make sure your product is turned on.
2. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
3. Select Printer Settings.
4. Click the Maintenance tab.
5. Click the Printer and Option Information button.

You see this screen:

6. Select the length of time after which you want the product to automatically turn off when it is not in
use as the Power Off Timer setting.
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7. Click Send.
8. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
9. Click Send.
10. Click OK to close the open program windows.
Parent topic: The Power Off and Sleep Timers

Changing the Power and Sleep Timer Settings - OS X
You can use the printer software to change the time period before the product enters sleep mode or
turns off automatically.
1. Make sure your product is turned on.
2. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

3. Select Printer Settings.
You see this window:
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4. Select the length of time after which you want the product to automatically turn off when it is not in
use as the Power Off Timer setting.

5. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
6. Click Apply.
7. Close the Printer Settings window.
Parent topic: The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More
You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print from
anywhere: Epson Email Print, Epson iPrint Mobile App, Epson Remote Print, and Epson Scan to Cloud.
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Using Epson Scan to Cloud
Parent topic: Product Basics

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product.
1. Set up your product for network printing. See the link below.
2. If you did not already set up Email Print when you installed your product software, visit

epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup
instructions.

3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your Epson Connect account.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking
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Using the Epson iPrint Mobile App
Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network. You can even scan and save a file on your device, send it as an email, or upload it to an online
service such as Box, Dropbox, Evernote, or Google Drive.
1. Set up your product on a network. See the link below.
2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile

device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print
With Epson Remote Print software, you can print to an Epson Email-enabled product anywhere in the
world.
1. Set up your product for network printing. See the link below.
2. Visit epson.com/connect to learn more about Remote Print and how to download the software.
3. Download and install the Remote Print software.
4. Obtain the email address and optional access key of the Epson product you want to use for printing,

and enter this address during Remote Print setup.
5. Select the print command in your application and choose the Remote Print driver for your Epson

product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud
The Epson Scan to Cloud service sends your scanned files to a destination that you have registered with
Epson Connect.
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1. Set up your product for network scanning. See the link below.
2. Visit epson.com/connect for instructions on registering an account and your product with Epson

Connect.
3. After registering, sign in to the Epson Connect web page with the email address and password you

selected.
4. Select Destination List for Scan to Cloud.
5. Click Add, then follow the instructions on the screen to create your destination list.
6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control

panel.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using AirPrint
AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X.

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
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Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print
With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

1. Connect your device to the same network that your Epson product is using.
2. Print a network status sheet.
3. Locate your product's IP address on the network status sheet.
4. Enter the IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
7. Select the checkbox to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.
9. Enter your Google Account username and password and click Sign in, or, if you don't have an

account, click Sign up for a new Google Account and follow the on-screen instructions.
10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics
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Related tasks
Printing a Network Status Sheet
Accessing the Web Config Utility
Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson product is connected to your wireless network before starting the Google
Cloud Print setup.

1. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

2. Do one of the following:
• Click Add to Cloud Print in the notification that appears in the corner of your Chromebook

screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

• Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
• If you see a registration confirmation screen instead, click Register.

3. Click Add Device.
4. Click the Register button that appears next to your product.
5. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation

message.
6. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and

print a test page.
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Your product is now linked to your Google Account and can be accessed from any Chromebook,
iPhone, or Android phone with Internet access. For more information on using Google Cloud Print,
visit Epson Support.

Parent topic: Using Google Cloud Print
Related topics
Wi-Fi or Wired Networking

Using the Mopria Print Service
You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here (website available in English only).

Parent topic: Product Basics
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Wi-Fi or Wired Networking
See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Wired Network Setup
Printing a Network Status Sheet
Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup
You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
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2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software from the product CD. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.

You see this screen:
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3. Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired
network connection in this guide.

4. Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, scroll down and then select Other Networks.
Use the displayed keypad to enter your network name, as described in the next step.

5. Enter your wireless password (or network name and then password) using the displayed keypad.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

• Press the touch screen buttons repeatedly to scroll through characters.
• Press or to move the cursor.
• Press 1 Symb. to enter symbols.
• Press to delete the previous character.

6. Press Done when you finish entering your password.
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7. Confirm the displayed network settings and select Proceed to save them.

Note: If you need to change a setting, press the Back button.

8. If you want to print a network setup report, press the Start button. (Otherwise, select Done.)
If the network connection is successful, a Wi-Fi antenna icon with blue connection bars is displayed
in the Network area on the right-hand side of the LCD screen.

Parent topic: Wi-Fi Infrastructure Mode Setup
Related tasks
Changing a Wi-Fi Connection to a Wired Network Connection
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Wi-Fi Direct Mode Setup
You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

1 Epson product
2 Computer with a wireless interface
3 Other wireless device

You can select one of these modes to communicate with your computer or device:
Access point mode

The product itself acts as the network access point for up to 4 devices. When operating in this mode,
your product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
The product communicates one-to-one with another Wi-Fi Direct capable device. When operating in
this mode, your product displays a Direct or D connection symbol on the LCD screen.
To disconnect a peer-to-peer mode connection, release the connection to your product from your
computer or other device.
To enable peer-to-peer mode, you must select it from the Web Config Utility, under WiFi/Network
Settings > Services > Wi-Fi Direct.

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking
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Enabling Wi-Fi Direct Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Press the home button, if necessary.
2. Select Network.
3. Select Setup.
4. Select Wi-Fi Direct Setup.

You see this screen:

5. Select Connection Setup.
6. Select Change Password and select OK.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will
be disconnected when you change the password.
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7. Enter your Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.

• Press the touch screen buttons repeatedly to scroll through characters.
• Press or to move the cursor.
• Press 1 Symb. to enter symbols.
• Press to delete the previous character.

8. Press Done when you finish entering your password.
You see this screen:
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9. Scroll down to view the SSID (Wi-Fi network name) and password.
10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the

LCD screen, then enter the password shown.

11. Press the home button to exit.
You see either an AP or Direct Wi-Fi symbol on the LCD screen and should be able to print directly
to your product from your computer or device.

Note: If the AP or Direct Wi-Fi symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not
enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network
If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the home button, if necessary.
2. Select Network.
3. Select Setup.
4. Select Wi-Fi Setup.
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You see this screen:

5. Select Push Button Setup (WPS).
6. Follow the instructions on the LCD screen to complete WPS setup.
7. Select OK if necessary.

If the network connection is successful, the Network icon on the right side of the LCD screen is blue
as shown:

Parent topic: Wi-Fi Protected Setup (WPS)

43



Wired Network Setup
You can set up your product to communicate with your computer over a wired network by connecting it to
the router or hub using an Ethernet cable.

1 Epson product
2 Ethernet cable
3 Ethernet hub
4 Computers with a wired network interfaces
5 Router
6 Internet

Parent topic: Wi-Fi or Wired Networking
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Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the home button, if necessary.
2. Select Network.
3. Select Details.
4. Scroll down and select Print Status Sheet.
5. Press the Start button to print the network status sheet.

(Select Cancel if you want to cancel the operation.)
Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.
Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi or Wired Networking
Related tasks
Printing a Network Status Sheet
Accessing the Web Config Utility

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.
1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.
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3. On a computer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the

Start Here sheet.
Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.
1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select Wired network connection.
8. If you see a Select Setup Option screen, select Set up printer for the first time.
9. Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections
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Connecting to a New Wi-Fi Router
If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
• Windows: Uninstall your product software.
• OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.
2. Select Network.
3. Select Setup.
4. Select Wi-Fi Setup.
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You see this screen:

5. Scroll down and select Disable Wi-Fi.
6. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes
Selecting the Paper Settings for Each Source - Control Panel
Printing on Thick Paper
Turning Off the Paper Setting Alert
Paper Loading Capacity
Available Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software

Loading Paper in Cassette 1 (Upper Cassette)
You can load photo paper and other media in these sizes in the upper paper cassette:
• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)

Note: Do not remove or insert the paper cassette during operation.

1. Close the output tray by pressing the Output Tray button on the LCD screen or by hand, if
necessary.
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Note: If you slide in the output tray by hand, there may be slight resistance and noise. This is
normal.

2. Open the front cover.

3. Pull out the upper paper cassette. (The upper cassette has a label on the right side.)

Note: If the cassette is too far inside the product to reach, turn the product off and on again.

4. Slide the edge guides outward.

50



5. Set the front edge guide to the position for the paper size you are using.

Note: Various paper sizes are marked on the tray.

6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the front edge guide and not sticking out from the end
of the cassette.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
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8. Keep the cassette flat as you insert it until the left and right arrow marks on the tray and product line
up.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. Do not remove or insert the paper cassette while the
product is operating.

9. If prompted by the product's LCD screen, select the size and type of the paper you loaded, and
select Done.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first and printable side facedown.
• Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the

cassette.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper or Media Type Settings - Printer Software
Paper or Media Type Settings - Control Panel
Related tasks
Selecting the Paper Settings for Each Source - Control Panel
Loading Paper in Cassette 2 (Lower Cassette)
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Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in Cassette 2 (Lower Cassette)
You can load paper up to this size in the lower paper cassette: Legal (8.5 × 14 inches [216 × 356 mm]).

Note: Do not remove or insert the paper cassette while the product is operating.

1. Close the output tray by pressing the Output Tray button or by hand, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.
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3. Pull on the front cover to remove the lower paper cassette.

4. Slide the edge guides outward.

Note: If you are using legal-size paper, remove the CD/DVD tray from under the lower cassette.
Press the button on the lower cassette and extend it as shown.
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5. Set the front edge guide to the paper size you are using.

Note: Various paper sizes are marked on the tray.

6. Insert paper with the glossy or printable side down.

Note: Make sure the paper is loaded against the front edge guide and not sticking out from the end
of the cassette.
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7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.

8. Keep the cassette flat as you insert it.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. Do not remove or insert the paper cassette while the
product is operating.

9. If prompted by the product's LCD screen, select the size and type of the paper you loaded, and
select Done.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
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• Load paper short edge first and printable side facedown.
• Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the

cassette.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper or Media Type Settings - Printer Software
Paper or Media Type Settings - Control Panel
Related tasks
Selecting the Paper Settings for Each Source - Control Panel
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in the Rear Paper Feed Slot
You can load one sheet of paper, card stock, other thick media, or one envelope in the rear paper feed
slot. You can load paper up to 11 × 17 inches (279 × 432 mm) / A3 (11.7 × 16.5 inches [297 × 420 mm]).

Note: Paper that is too stiff may not load correctly even if it is within the paper specifications.

1. Send your print job from a computer or using the product's touch screen.
• If printing from a computer, select Rear Paper Feed Slot for the Source (Windows) or Paper

Source (OS X) setting.
• If printing from the product's touch screen, select Rear Paper Feed Slot for the Paper Source

setting.
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2. Flip open the rear paper feed slot cover.

3. Fully extend the paper support and tilt it back, as shown.

58



4. Slide the edge guides outward.

5. Do one of the following:
• Load a single sheet of paper or thick media, printable side up and short edge first, in the center of

the rear paper feed slot until you hear a beep. Slide the edge guides against the paper, but not too
tightly.

Note: If the Button Press setting is turned off, you will not hear a beep when inserting paper.
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• Load an envelope, short edge first with the flap facing down and to the left, in the center of the rear
paper feed slot until you hear a beep. Slide the edge guides against the envelope, but not too
tightly.

6. When you are ready to print, press the Start button.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. To cancel printing, select Cancel.

7. If prompted by the product's LCD screen, select the size and type of the paper you loaded, and
select Done.

Always follow these loading guidelines:
• Load one sheet or envelope at a time.
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• Be careful not to insert paper too far or not far enough. Feed about 2 inches (5 cm) of paper into the
printer as shown.

1 2 inches (5 cm)

• Do not insert paper at an angle or the paper may jam or wrinkle.
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• You can load hole-punched paper with holes on either side, but you may need to adjust the margins in
your print file to avoid printing over the holes.

• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper or Media Type Settings - Printer Software
Paper or Media Type Settings - Control Panel
Related tasks
Selecting the Paper Settings for Each Source - Control Panel
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Envelopes

Loading Envelopes
You can load envelopes in Cassette 2 (lower cassette) as described here. You can print on plain paper
envelopes in this size: No. 10 (4.1 × 9.5 inches [105 × 241 mm]).
You can also load a single envelope in the rear paper feed slot, as described in that section.

Note: Do not remove or insert the paper cassette during printing.
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1. Close the output tray by pressing the Output Tray button or by hand, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.

3. Pull on the front cover to remove the lower paper cassette.
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4. Slide the edge guides outward.

5. Insert up to 10 envelopes, printable side down and flap edge left, as shown.

Note: Make sure the envelopes are not sticking out from the end of the cassette.

6. Slide the edge guides against the envelopes, but not too tightly.

Note: Make sure the envelopes are under the tabs on the edge guides.
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7. Keep the cassette flat as you insert it.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. Do not remove or insert the paper cassette while the
product is operating.

8. If prompted by the product's LCD screen, select the size and type of the envelope you loaded, and
select Done.

Always follow these envelope loading guidelines:
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• Do not load envelopes that are curled, folded, or too thin.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper or Media Type Settings - Printer Software
Paper or Media Type Settings - Control Panel
Related tasks
Selecting the Paper Settings for Each Source - Control Panel
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in the Rear Paper Feed Slot

Selecting the Paper Settings for Each Source - Control Panel
You can change the default paper size and paper type for each source using the control panel on the
product.
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1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
4. Select Paper Source Setting.

You see this screen:

Note: To turn off the automatic display of the paper settings selection screen after paper is loaded in
the cassettes, set the Paper Configuration setting to Off. If you do this, you will not be able to use
AirPrint.

5. Select Paper Setup.
6. Select the paper source you want to change.
7. Select Paper Size.
8. Select the paper size you loaded.
9. Select Paper Type.
10. Select the paper type you loaded.

11. Press the Back button to select another paper source to change, or press the home button to
exit.

Parent topic: Loading Paper
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Printing on Thick Paper
If ink smears when you print on thick paper, you can select the Thick Paper setting to improve print
quality. Printing is slower with this setting.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.

You see this screen:

4. Select Thick Paper.
5. Select On.

6. Press the home button to exit.
Parent topic: Loading Paper

Turning Off the Paper Setting Alert
The Paper Setting Alert warns you when the paper settings do not match the paper you loaded. You can
turn off this feature from the control panel.

1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select Guide Functions.
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You see this screen:

4. Select Paper Setting Alert.
5. Select Off.
6. Press the home button to exit.
Parent topic: Loading Paper

Paper Loading Capacity
Load one sheet of paper or one envelope at a time in the rear paper feed slot. See the table here for the
loading capacity of the paper cassettes.

Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)

Plain paper Letter (8.5 × 11 inches —
[216 × 279 mm]), A4 (8.3 × 11.7
inches [210 × 297 mm]), or Legal
(8.5 × 14 inches [216 × 356 mm])
size: 100 sheets

Epson Bright White Paper 80 sheets —
Epson Presentation Paper Matte
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Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)

Epson Premium Presentation 20 sheets —
Paper Matte
Epson Ultra Premium Presentation
Paper Matte
Epson Photo Paper Glossy 20 sheets 20 sheets
Epson Premium Photo Paper
Glossy
Epson Ultra Premium Photo Paper
Glossy
Epson Premium Photo Paper
Semi-gloss
Epson Ultra Premium Photo Paper
Luster
Epson Premium Presentation 1 sheet —
Paper Matte Double-sided
Epson Photo Quality Self-adhesive
Sheets
Epson Iron-on Cool Peel Transfer
paper
Epson Velvet Fine Art Paper
Epson Brochure & Flyer Paper
Matte Double-sided
Envelopes 10 envelopes —

Parent topic: Loading Paper

Available Epson Papers
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

69

http://www.epson.com/ink3
http://www.epson.ca


Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 × 11 inches S041586 500

[216 × 279 mm])
Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809 50

S042038 100
Letter (8.5 × 11 inches S041141 20
[216 × 279 mm]) S041649 50

S041271 100
11 × 17 inches S041156 20
(279 × 432 mm)

Epson Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041808 40
Glossy S041727 100

5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches S042183 25
[216 × 279 mm]) S041667 50
11 × 14 inches S041466 20
(279 × 356 mm)
11 × 17 inches S041290 20
(279 × 432 mm)
A3 (11.7 × 16.5 inches S041288 20
[297 × 420 mm])

Epson Ultra Premium Photo Paper 4 × 6 inches (102 × 152 mm) S042181 60
Glossy S042174 100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches S042182 25
[216 × 279 mm]) S042175 50
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Paper Type Size Part number Sheet count
Epson Ultra Premium Photo Paper Letter (8.5 × 11 inches S041405 50
Luster [216 × 279 mm])

A3 (11.7 × 16.5 inches S041406 50
[297 × 420 mm])

Epson Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041982 40
Semi-gloss Letter (8.5 × 11 inches S041331 20

[216 × 279 mm])
Epson Presentation Paper Matte Letter (8.5 × 11 inches S041062 100

[216 × 279 mm])
Legal (8.5 × 14 inches S041067 100
[216 × 356 mm])
11 × 17 inches S041070 100
(279 × 432 mm)

Epson Premium Presentation 8 × 10 inches (203 × 254 mm) S041467 50
Paper Matte Letter (8.5 × 11 inches S041257 50

[216 × 279 mm]) S042180 100
11 × 14 inches S041468 50
(279 × 356 mm)
A3 (11.7 × 16.5 inches S041260 50
[297 × 420 mm])

Epson Premium Presentation Letter (8.5 × 11 inches S041568 50
Paper Matte Double-sided [216 × 279 mm])
Epson Ultra Premium Presentation Letter (8.5 × 11 inches S041341 50
Paper Matte [216 × 279 mm])

A3 (11.7 × 16.5 inches S041343 50
[297 × 420 mm])

Epson Brochure & Flyer Paper Letter (8.5 × 11 inches S042384 150
Matte Double-sided [216 × 279 mm])
Epson Photo Quality Self-adhesive A4 (8.3 × 11.7 inches S041106 10
Sheets [210 × 297 mm])
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Paper Type Size Part number Sheet count
Epson Iron-on Cool Peel Transfer Letter (8.5 × 11 inches S041153 10
paper [216 × 279 mm])
Epson Velvet Fine Art Paper Letter (8.5 × 11 inches S041636 20

[216 × 279 mm])

Parent topic: Loading Paper

Borderless Paper Type Compatibility
You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
• Epson Photo Paper Glossy
• Epson Premium Photo Paper Glossy
• Epson Ultra Premium Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss
• Epson Ultra Premium Photo Paper Luster
• Epson Premium Presentation Paper Matte
• Epson Ultra Premium Presentation Paper Matte

Borderless Paper Sizes
• 4 × 6 inches (102 × 152 mm)
• 16:9 wide (4 × 7.1 inches [102 × 181 mm])
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• Letter (8.5 × 11 inches [216 × 279 mm])
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• A3 (11.7 × 16.5 inches [297 × 420 mm])
• 11 × 17 inches (279 × 432 mm)
Parent topic: Loading Paper
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Paper or Media Type Settings - Control Panel
For this paper Select this Paper Type setting
Plain paper Plain Paper
Epson Bright White Paper
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets
Epson Ultra Premium Photo Paper Glossy Ultra Glossy
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Photo Paper Glossy Glossy
Epson Presentation Paper Matte Presentation Matte
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Ultra Premium Photo Paper Luster Ultra Luster
Epson Premium Presentation Paper Matte Prem. Matte
Epson Premium Presentation Paper Matte Double-
sided
Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided
Epson Velvet Fine Art Paper Velvet Fine Art Paper
Envelopes Envelope

Parent topic: Loading Paper

Paper or Media Type Settings - Printer Software
For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper/Bright White Paper
Epson Bright White Paper
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets
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For this paper Select this paper Type or Media Type setting
Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy
Epson Presentation Paper Matte Presentation Paper Matte
Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Ultra Premium Photo Paper Luster Ultra Premium Photo Paper Luster
Epson Premium Presentation Paper Matte Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided
Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided
Epson Velvet Fine Art Paper Velvet Fine Art Paper
Envelopes Envelope

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or
A4 (8.3 × 11.7 inches [210 × 297 mm]).
1. Open the document cover.
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2. Place your original facedown on the scanner glass with the top of the original facing into the corner
shown. Slide the original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least 0.20
inch (5 mm) away from each other and from the edge of the scanner glass.

76



3. If you are copying two book pages onto one sheet, place the book as shown to copy the first page,
then turn the book as shown to copy the second page.

4. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
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Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying and Restoring Photos
Related tasks
Copying onto a CD/DVD

Copying Documents or Photos
You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.
1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on.

Note: Load only the recommended number of sheets.

3. Press the home button, if necessary.
4. Select Copy.
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5. To print more than one copy, press the + or – button to select the number (up to 99).
6. Select Color or B&W.
7. Scroll down to view and change additional copy settings, if necessary.
8. When you are ready to copy, press the Start button.

Note: To cancel copying, select Cancel.

Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options
Parent topic: Copying
Related references
Paper Loading Capacity
Available Epson Papers
Related tasks
Placing Originals on the Scanner Glass

Paper Type Settings - Copying
Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper
Epson Bright White Paper
Epson High Quality Ink Jet Paper
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets
Epson Presentation Paper Matte Presentation Matte
Epson Premium Presentation Paper Matte Prem. Matte
Epson Ultra Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-sided
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Paper type loaded Paper Type setting
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Ultra Premium Photo Paper Luster
Epson Ultra Premium Photo Paper Glossy Ultra Glossy
Epson Photo Paper Glossy Glossy
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Velvet Fine Art Paper Velvet Fine Art paper

Parent topic: Copying Documents or Photos

Paper Size Settings - Copying
Select the Paper Size setting that matches the paper you loaded.

Note: You can copy photos only on these paper sizes.

• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• Letter (8.5 × 11 inches [216 × 279 mm])
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• A3 (11.7 × 16.5 inches [297 × 420 mm])
• 11 × 17 inches (279 × 432 mm)
Parent topic: Copying Documents or Photos

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Copying option Available settings Description
Density Varying levels Adjusts the lightness or darkness of copies
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Copying option Available settings Description
Remove Background Off Removes or lightens the background color. May

not remove very dark or vivid colors.On
2-Sided Copying 1>1-Sided Selects 1-sided or make 2-sided copies

1>2-Sided
Layout With Border Leaves a small margin around the image

Borderless Expands the image to the edge of the paper
(slight cropping may occur)

A4, 2-up Copy Copies 2 originals onto a single A4-size sheet
Letter, 2-up Copy Copies 2 originals onto a single letter-size sheet
A4, Book/2-up Copies 2 pages of a book or magazine onto a

single A4-size sheet
Letter, Book/2-up Copies 2 pages of a book or magazine onto a

single letter-size sheet
Book/2-sided Copies 2 pages of a book or magazine onto both

sides of a single sheet (only available when 1>2-
Sided is selected)

Reduce/Enlarge Custom Size Automatically sizes the image by the percentage
you select

Actual Size Copies at 100% size
Auto Fit Page Automatically sizes the image to fit the selected

paper size setting
Letter->4x6in and other Automatically converts from one size to another
conversions

Paper Size Various sizes Selects the paper size for the copy printout
Paper Type Various types Adjusts printer settings for the selected paper

type
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Copying option Available settings Description
Paper Source Cassette 1 Copies onto paper loaded in Cassette 1 (upper

cassette)
Cassette 2 Copies onto paper loaded in Cassette 2 (lower

cassette)
Rear Paper Feed Slot Copies onto paper loaded in the rear paper feed

slot
Document Type Text Copies a text document

Text & Image Copies a document that includes text and
images

Photo Copies a photograph
Quality Draft Provides lower quality for draft copies (plain

paper only)
Standard Provides good quality for most copies
Best Provides the highest quality for special copies

Document Portrait Specifies the orientation of your originals (only
Orientation available when 1>2-Sided is selected)Landscape
Binding Margin Left Edge Specifies the binding edge of your double-sided

copies (only available when 1>2-Sided isTop Edge selected)
Expansion Standard Adjusts the amount of expansion for printing

borderless photosMedium
Minimum

Dry Time Standard Provides longer drying time for 2-sided copies, if
smudges or marks appear on the front of theLong paper when you print on the second side

Longer
Clear All Settings — Restores the copy settings to the default settings

Parent topic: Copying Documents or Photos
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Copying and Restoring Photos
You can restore the colors in faded photos as you copy them.
1. Load photo paper in the product.

2. Press the home button, if necessary.
3. Select More Functions.
4. Select Copy/Restore Photos.

5. Select On.
6. Place up to two original photos on the product.

Note: View the LCD screen for instructions on placing your photos on the product.

7. Press the Start button.
8. Press the + or – button to select one or more copies of the photo (up to 99).
9. If you placed two originals on the scanner, press the left or right arrow button to view the second

original. Then press the + or – button to select one or more copies of the photo (up to 99).
10. To adjust your print and copy settings, do one or more of the following:

• To change the print settings, select Settings and select the necessary settings.
• To adjust the copy image, select Edit > Photo Adjustments and select your settings.
• To add a B&W filter to the copy, select Edit > Filter and select the B&W setting.
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• To crop or zoom into your photo, select Edit > Crop/Zoom and press the icons displayed on the
LCD screen to crop your image.

11. When you are ready to print, press the Start button.

Note: To cancel copying, select Cancel.

Parent topic: Copying
Related references
Paper Loading Capacity
Available Epson Papers
Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options
Related tasks
Placing Originals on the Scanner Glass
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with OS X
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.
Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.
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3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size, but you will not
be able to use the Borderless setting.
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6. If you are printing a borderless photo, select Borderless. You can click Settings to access
additional options for borderless printing.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

7. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

8. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

9. Select the Quality setting that matches the print quality you want to use.
10. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

11. To print on both sides of the paper, select a 2-Sided Printing option.
12. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

one of the settings in the Multi-Page menu and select the printing options you want.
13. To print multiple copies and arrange their print order, select the Copies options.
14. To reduce noise during printing when you select Plain Paper/Bright White Paper, select Quiet

Mode (printing will be slower).
15. To preview your job before printing, select Print Preview.
16. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references
Paper or Media Type Settings - Printer Software
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Borderless Paper Type Compatibility
Related tasks
Selecting Double-sided Printing Settings - Windows
Turning On Quiet Mode

Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.
Auto Cassette Selection

Automatically selects the paper source based on the selected paper size.
Cassette 1

Selects the paper in cassette 1 as the paper source.
Cassette 2

Selects the paper in cassette 2 as the paper source.
Cassette 1 > Cassette 2

Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when
cassette 1 is empty.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

CD/DVD Tray
Selects the CD or DVD loaded in the CD/DVD tray.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
Standard

For everyday text and image printing.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
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Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
• Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper

on the long edge.
• Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper

on the short edge.
• Manual (Long-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

• Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).
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2. Click the Settings button.
You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.

90



5. Click the Print Density button.
You see this window:

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.
8. Click OK to return to the Main tab.
9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options - Windows
Print Density Adjustments - Windows
Parent topic: Printing with Windows

Double-sided Printing Options - Windows
You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.
Print Density

Sets the level of ink coverage for double-sided printing.
Increase Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the

your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
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• Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.

Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:
• Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout.

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.
Print Text in Black

Prints colored text in black.
For Color Text

Prints colored text on a background pattern or underlined.
For Color Graphs and Images

Prints colored graphics and images with overlay patterns.
For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.
Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
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Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available Printing Presets on the left:
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2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control

your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.
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You see the maintenance options:

4. Click the Extended Settings button.
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You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select from these settings on the Extended Settings window.
Show Progress Meter

Displays the progress of print jobs as they are being printed.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Check Paper Width Before Printing

Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.
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Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
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Checking Print Status - Windows
During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.

• To cancel printing, click Cancel.
• To see print jobs waiting to print, click Print Queue.
• To check ink status, click Consumables Status.
Parent topic: Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
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You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window.
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3. Click the Maintenance tab.
You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
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You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with OS X
You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X
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Selecting Double-sided Printing Settings - OS X
Managing Color - OS X
Selecting Printing Preferences - OS X
Printing Your Document or Photo - OS X
Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the version of OS X and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.
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You see these settings:

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.
Paper Source Options - Mac OS X
Print Quality Settings - OS X
Print Options - OS X
Parent topic: Printing with OS X
Related references
Paper or Media Type Settings - Printer Software
Related tasks
Printing Your Document or Photo - Windows
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Selecting Page Setup Settings - OS X
Paper Source Options - Mac OS X

You can select any of the available options in the Paper Source menu to print from paper loaded in that
source.
Cassette 1

Selects the paper in cassette 1 as the paper source.
Cassette 2

Selects the paper in cassette 2 as the paper source.
Rear Paper Feed Slot

Selects the paper in the rear feed slot as the paper source.
Parent topic: Selecting Basic Print Settings - OS X

Print Quality Settings - OS X
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on photo paper.
Fast Economy

For the fastest printing with draft quality.
Economy

For fast printing with reduced quality.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Quality

For photos and graphics with good quality and print speed.
Best Quality

For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - OS X

Print Options - OS X
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
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Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to
Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.
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Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with OS X
Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - OS X
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with OS X
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Selecting Double-sided Printing Settings - OS X
You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - OS X
Parent topic: Printing with OS X

Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.

Two-sided Printing Options
Long-Edge binding

Orients double-sided printed pages to be bound on the long edge of the paper.
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Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Adjustments
Print Density

Sets the level of ink coverage for double-sided printing.
Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - OS X
Parent topic: Printing with OS X

Color Matching and Color Options - OS X
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.
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You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X

Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing but may decrease print speed.
Permit temporary black printing

Allows you to print using black ink when color ink is expended.
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Automatic Cassette Switching
Automatically switches to the other cassette when one of the cassettes runs out of paper.

High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - OS X
Parent topic: Printing with OS X

121



Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:

2. Select the following options as necessary for your version of OS X:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - OS X

Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD screen.
Parent topic: Printing from a Computer
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Scanning
You can scan original documents or photos and save them as digital files.
Starting a Scan
Selecting Epson Scan Settings
Scanning with OS X Using Image Capture
Scanning Special Projects

Starting a Scan
After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.
Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan Icon
Starting a Scan from a Scanning Program
Parent topic: Scanning
Related tasks
Placing Originals on the Scanner Glass

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's touch panel buttons.
Your product automatically selects suitable default scan settings, but you can view or change them as
necessary.
1. Make sure you installed the product software and connected the product to your computer or

network.

Note: Restart your computer after installing the product software to enable scanning from the control
panel. Also make sure the Event Manager program is not being blocked by your firewall or security
software.

2. Press the home button, if necessary.
3. Select Scan.
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The scan options are displayed:

4. Scroll up or down to view additional scan options, then select the one you want.
• Scan to Memory Card saves your scan file on a memory card and lets you select the file format,

quality, and other settings.
• Scan to Cloud sends your scanned files to a destination that you have registered with Epson

Connect.

Note: To use this feature, you must have registered a cloud account with Epson Connect.

• Scan to Computer (JPEG) saves your scan file directly to your computer or as an image capture
in OS X .

• Scan to Computer (PDF) saves your scan as a PDF file to your computer or as an image capture
in OS X.

• Scan to Computer (Email) scans your original and attaches it to a message in your e-mail
program. You can select the e-mail program you want to use and resize your image, if necessary,
from an option screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,
and Entourage, but not web-based email such as Gmail.

• Scan to Computer (WSD) lets you manage wireless scanning in Windows 8.x, Windows 7, or
Windows Vista (English only).
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Note: To use this feature, you must first set up WSD (Web Services for Devices) on the computer
you want to scan to.

5. To scan to your PC, select how you connected your product to your computer:
• If your product is connected directly to your computer with a USB cable, select USB Connection.
• If your product is connected to your computer over a network, select the computer name from the

list.
6. Press the Start button to start scanning.
Scan to Memory Card Options
Changing Default Scan Button Settings
Parent topic: Starting a Scan
Related tasks
Using Epson Scan to Cloud

Scan to Memory Card Options
Select the Scan to Memory Card options you want to use.

Scan to Memory Card Available options Description
setting
JPG — JPG: for photos
PDF PDF: for documents
Color — Select color or black-and-white

scansB&W
Contrast Various levels Decrease or increase image

contrast
Scan Area Letter Selects the page size for documents

or special settings for photos.A4
Auto Cropping: for photos withAuto Cropping dark edges

Max Area Max Area: for most photos
Document Text Selects the type of original you are

scanningPhotograph
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Scan to Memory Card Available options Description
setting
Resolution 200 dpi 200 dpi: for e-mailing or posting on

the web300 dpi
300 dpi: for printing or OCR600 dpi
600 dpi: for highest quality printing

Document Orientation Portrait Specifies the orientation of your
originalsLandscape

Parent topic: Starting a Scan Using the Product Control Panel
Changing Default Scan Button Settings

You can view or change the default scan settings your product uses when you scan to your computer
using the product buttons. You do this using the Event Manager program.
1. Do one of the following to open Event Manager:

• Windows 8.x: Navigate to the Apps screen and select Event Manager.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON Software
> Event Manager.

• OS X: Open the Applications folder, click Epson Software, and click Event Manager.
2. Open the Scanner (Windows) or Select Scanner (OS X) drop-down list and select your product, if

necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan button settings you want to view or

change.
5. Change the settings as necessary.
6. Click OK.
7. Click Close to close the Event Manager window.
Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the Epson Scan Icon
You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a
file.
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• Windows 8.x: Navigate to the Apps screen and select EPSON Scan under EPSON or EPSON
Software.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
or EPSON Software and click EPSON Scan.

• OS X: Open the Applications folder, open the Epson Software folder, and double-click the EPSON
Scan icon.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).
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You see an Epson Scan window like this:

Parent topic: Starting a Scan
Related tasks
Scanning with OS X Using Image Capture
Related topics
Selecting Epson Scan Settings
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Starting a Scan from a Scanning Program
You can start Epson Scan from a TWAIN-compliant scanning program to select scan settings, scan, and
open the scanned image in the program.
1. Open your scanning program and select its scanning option. (See your scanning program help for

instructions.)
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2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.

You see an Epson Scan window like this:
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Note: In certain programs, you may see the program's scan window instead of the Epson Scan
window. Select scanning options as necessary.

Parent topic: Starting a Scan

Selecting Epson Scan Settings
After starting Epson Scan, you can select settings in various modes to customize your scan.
Scan Modes
Selecting the Scan Mode
Scanning in Full Auto Mode
Scanning in Home Mode
Scanning in Office Mode
Scanning in Professional Mode
Image Preview Guidelines
Scan Resolution Guidelines
Selecting Scan File Settings
Parent topic: Scanning

Scan Modes
Epson Scan provides a choice of scan modes with different levels of control over your settings.
Full Auto Mode

This mode automatically detects the type of content you are scanning, selects settings for it, and
saves your scanned image. You can also select various image adjustment options.

Home Mode
You can select setting groups based on the type of content you are scanning. You can also select
various image adjustment options, and preview and size your scanned image.

Office Mode
You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Parent topic: Selecting Epson Scan Settings
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Related tasks
Selecting the Scan Mode

Selecting the Scan Mode
Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson
Scan window:

Parent topic: Selecting Epson Scan Settings
Related tasks
Scanning in Full Auto Mode
Scanning in Home Mode
Scanning in Office Mode
Scanning in Professional Mode

Scanning in Full Auto Mode
When you scan in Full Auto Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
change the scanned file settings and select various image adjustment options before you scan, if
necessary.
1. Start Epson Scan and select Full Auto Mode as the Mode setting.
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You see this window:
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2. To select image adjustment options or change your scanned file settings, click Customize, select
the settings you want, and click OK.

• To choose any of the available image adjustment options, select the checkbox for the option.
• To change the scanned file settings, click File Save Settings.

3. Click Scan.
Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.
Available Image Adjustments - Full Auto Mode
Parent topic: Selecting Epson Scan Settings
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Related concepts
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings

Available Image Adjustments - Full Auto Mode
You can select these image adjustment options in Epson Scan Full Auto Mode.
Dust Removal

Removes dust marks from your originals automatically.
Color Restoration

Restores the colors in faded photos automatically.
Auto Photo Orientation

Checks the preview image for faces, the sky, and other features, and then correctly rotates the photo
when it is scanned, if necessary. (If your photo is not oriented correctly using this option, deselect this
option and scan again.)

Parent topic: Scanning in Full Auto Mode

Scanning in Home Mode
When you scan in Home Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.
1. Start Epson Scan and select Home Mode as the Mode setting.
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You see this window:

2. Select the Document Type setting that matches your original, such as Photograph or Text/Line
Art.

3. Select the Image Type setting that matches your original.
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4. Select the way you plan to use your scanned image as the Destination setting. (The Resolution
setting is selected automatically based on the Destination setting you choose.)
• Screen/Web: Select this option for images you will email, view on a computer screen, or post on

the web.
• Printer: Select this option for images you will print or documents you will convert to editable text

using OCR (Optical Character Recognition) software.
• Other: Select this option if you want to select a custom resolution for your image.

5. If you selected Other in the last step, select the Resolution setting you want to use for your scan.
6. Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).
8. Select any of the image adjustment settings you want to use. Before making adjustments, click the

image or scan area in the Preview window.
9. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to

use.
10. Click Scan.

You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.
Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.
Selecting a Scan Area - Home Mode
Available Image Adjustments - Home Mode
Selecting a Scan Size - Home Mode
Parent topic: Selecting Epson Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings
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Selecting a Scan Area - Home Mode
You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).
You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. Do one of the following to select your scan area in the Preview image:
• Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your

cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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• Normal preview: Click the Auto Locate icon to create a marquee (dotted line) on the preview
image.

2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

• Normal preview: To create additional marquees (up to 50), click the Copy Marquee icon to
copy the existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.
3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Home Mode

Available Image Adjustments - Home Mode
You can select these Image Adjustments options in Epson Scan Home Mode.

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Document Type and Image Type setting.
Click the Brightness button to access additional settings.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.
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Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Home Mode
Selecting a Scan Size - Home Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 × 6 inches (102 × 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.
1. Click the Preview button to preview your image.
2. In the Epson Scan window, select the size you want your scanned image to be from the Target Size

list.

Note: If you need to rotate the orientation of the target size for your image, click the Orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.

3. Do the following, as necessary, to work with the selected scan area:
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.

4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.
You see this window:

5. Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.
The marquee is automatically proportioned for your custom scan size.

Parent topic: Scanning in Home Mode
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Scanning in Office Mode
When you scan in Office Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.
1. Start Epson Scan and select Office Mode as the Mode setting.

You see this window:
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2. Select the Image Type setting that matches your original.
3. Select the Document Source setting indicating where you placed your original.
4. Select the Size and Orientation settings that match your original.
5. Select the Resolution setting you want to use for your scan.
6. Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).
8. Select any of the image adjustment settings you want to use. Before making adjustments, click the

image or scan area in the Preview window.
9. Click Scan.

You see the File Save Settings window.
10. Change any of the necessary file save settings and click OK.
Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.
Selecting a Scan Area - Office Mode
Available Image Adjustments - Office Mode
Parent topic: Selecting Epson Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings

Selecting a Scan Area - Office Mode
You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.
You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. In the Preview window, click the Auto Locate icon to create a marquee (dotted line) on the
preview image.

2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

• To create additional marquees (up to 50, if available), click the Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.
3. Click inside each scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Office Mode

Available Image Adjustments - Office Mode
You can select these Image Adjustments options in Epson Scan Office Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox. Not all adjustment settings may be available, depending on the Image Type
setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Professional Mode
When you scan in Professional Mode, Epson Scan automatically saves your scanned file in JPEG
format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.
1. Start Epson Scan and select Professional Mode as the Mode setting.
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You see this window:
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2. Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

3. Select the Document Source setting indicating where you placed your original.
4. Select the specific type of original you are scanning as the Auto Exposure Type setting: Document

or Photo.
5. Select the details of your original and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
8. If desired, select the area in your preview image that you want to scan (scan area).
9. Select any of the image adjustment settings you want to use. Before making adjustments, click the

image or scan area in the Preview window.
10. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to

use.
11. Click Scan.

You see the File Save Settings window.
12. Change any of the necessary file save settings and click OK.
Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.
Available Image Types - Professional Mode
Selecting a Scan Area - Professional Mode
Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode
Parent topic: Selecting Epson Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings
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Available Image Types - Professional Mode
You can select these Image Type options in Epson Scan Professional Mode.
24-bit Color

Select this setting for color photos.
Color Smoothing

Select this setting for color graphic images, such as charts or graphs.
8-bit Grayscale

Select this setting for black-and-white photos.
Black & White

Select this setting for black text documents or line art.
Parent topic: Scanning in Professional Mode

Selecting a Scan Area - Professional Mode
You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).
You can also use the scan area to select specific image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal Preview mode. To use Thumbnail
Preview mode instead, select the Thumbnail checkbox beneath the Preview button (if available), then
click the Preview button to preview your image again.
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1. Do one of the following to select your scan area in the Preview image:

• Normal preview: Click the Auto Locate icon to create a marquee (dotted line) on the preview
image.
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• Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.

2. Do the following, as necessary, to work with the selected scan area:
• If the marquee is correct, continue with the next step.
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

• Normal preview: To create additional marquees (up to 50, if available), click the Copy
Marquee icon to copy the existing marquee and paste it on the preview image.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Professional Mode

Available Image Adjustments - Professional Mode
You can select these Adjustments options in Epson Scan Professional Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Click the image adjustment icon to access additional settings.
Click the + (Windows) or (OS X) icon next to a setting to change the level of adjustment.
Unsharp Mask

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Auto Exposure
Automatically adjusts the image exposure settings when you click the Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of auto exposure using a
slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For
advanced users only.) Click the histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click
the tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.

Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the
highlight and shadow areas of the image. (For advanced users only.) Click the Color Palette icon
to access the settings.
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Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
Selecting a Scan Size - Professional Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 × 6 inches (102 × 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.
1. Click the Preview button to preview your image.
2. In the Epson Scan window, select the size you want your scanned image to be from the Target Size

list.

Note: If you need to rotate the orientation of the target size for your image, click the orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.

3. Do the following, as necessary, to work with the selected scan area:
• To move the marquee, click inside the scan area and drag the marquee where you want it.
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• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.

4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.
You see this window:

5. Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.
The marquee is automatically proportioned for your custom scan size.
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6. To use additional sizing tools, click the + (Windows) or (OS X) icon next to the Target Size setting
and select options as desired.

• Scale: Reduces or enlarges your image by the percentage you enter.
• Trimming: Turns automatic image cropping on or off.

• Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust
it without constraint.

Parent topic: Scanning in Professional Mode

Image Preview Guidelines
You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:
Thumbnail preview

A thumbnail preview displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected. If the Thumbnail checkbox is selected, clicking the Preview button
opens a thumbnail preview.

Normal preview
A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually. If the Thumbnail checkbox is deselected, clicking the
Preview button opens a normal preview.

Parent topic: Selecting Epson Scan Settings

Scan Resolution Guidelines
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the
resolution setting you need:
• You will enlarge the image as you scan it.
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If you will enlarge the image using Epson Scan's Target Size setting, you do not need to increase the
Resolution setting.

• You will scan the image at its original size but enlarge it later in an image-editing program.
Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

• You will scan the image at 100% or smaller size.
Select Epson Scan's Resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 150 dpi
• Print/convert to editable text (OCR): 300 dpi
• Fax: 200 dpi

Parent topic: Selecting Epson Scan Settings
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Selecting Scan File Settings
You can select the location, name, and format of your scan file on the File Save Settings window. You
can also select various optional settings that control how Epson Scan behaves when you scan and save
files.

The File Save Settings window may appear after you click Scan on the Epson Scan window. You may
also be able to access the window by clicking the icon on the Epson Scan window.
1. Do one of the following to select the folder in which you want to save your scanned image:

• Click the button for one of the displayed folders.
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• Click the Other button, click the Browse or Choose button, and select a folder.
2. Type in a file name in the Prefix field. This name is used along with numbers to automatically name

your scanned files.
3. Select a different number as the Start Number setting, if you like.
4. Select the file format you want to use in the Image Format Type menu.
5. If your file format provides optional settings, click the Options button to select them.
6. Choose any of the optional settings you want to use by selecting their checkboxes.
7. Click OK.
Available Scanned File Types and Optional Settings
Parent topic: Selecting Epson Scan Settings

Available Scanned File Types and Optional Settings
You can select from a variety of scanned file types and optional settings on the File Save Settings
window in Epson Scan.

File Formats
Bitmap (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and OS X systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most OS X programs.

PRINT Image Matching II (*.jpg or *.tif)
File formats that include Epson PRINT Image Matching II data for enhanced quality and a wider color
range (does not affect the way the image displays on the screen).
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TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Optional Settings
Overwrite any files with the same name

Select to overwrite previous files with the same names.
Show this dialog box before next scan

Select to have the File Save Settings window appear automatically before you scan (in certain Epson
Scan modes).

Open image folder after scanning
Select to have Windows Explorer or OS X Finder automatically open to the folder where your scanned
image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-TIFF format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with OS X Using Image Capture
With OS X, you can scan with your product using an image-editing application such as Image Capture.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open an image editing application, such as Image Capture.
2. Select your Epson product from the DEVICES or SHARED list in the Finder, if necessary. (You may

need to hover over the DEVICES or SHARED list, click Show, and select your product.)
3. If you see the Show Details button, click it.

If you are scanning an item on the scanner glass, your product begins a preview scan.
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4. Select the Scan Mode setting indicating where you placed your original (if available). Select any
other available scan settings as necessary.

5. Select the folder in which you want to save your scanned file in the Scan To pop-up menu.
6. Click Scan.

165



Your scanned file is saved in the folder you selected.
Available Scan Settings - OS X Image Capture
Parent topic: Scanning

Available Scan Settings - OS X Image Capture
You can select these scan settings in your imaging editing application for OS X, if available.
Image Correction

Provides a graphical interface for adjusting brightness, tint, temperature, and saturation.
Unsharp Mask

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
Descreening

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Parent topic: Scanning with OS X Using Image Capture

Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan
projects.
Scanning to a PDF File
Restoring Photo Colors as You Scan
Scanning to Online Destinations Using Easy Photo Scan
Parent topic: Scanning

Scanning to a PDF File
Using Epson Scan in Office, Home, or Professional Mode, you can scan a multi-page document and
save it in one PDF (Portable Document Format) file on your computer.
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1. Place your original on your product for scanning.
2. Start Epson Scan.
3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. When you finish selecting all your settings, click Scan.

You see the File Save Settings window.

7. Select PDF as the Type setting.
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8. Select any other settings you want to use on the File Save Settings window. Click the Options
button to access additional settings.

9. Click OK.
Epson Scan scans your document and you see this window:

10. Choose one of the following options:
• If you are scanning only one page, click Save File.
• If you need to scan additional pages in a document, click Add page. Place additional pages on

the product for scanning, click Scan, and repeat until you have scanned all the pages. When you
are finished, click Save File.

• If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

11. Click Close to exit the Epson Scan window, if necessary.
Epson Scan scans your original, and saves the PDF file in the selected folder or opens it in your
scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or OS X Finder, where you can view and print the document, if desired.
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Parent topic: Scanning Special Projects
Related tasks
Starting a Scan Using the Epson Scan Icon
Selecting the Scan Mode
Selecting Scan File Settings

Restoring Photo Colors as You Scan
You can restore the colors in faded photos as you scan them using Epson Scan's Color Restoration
setting. You can select this setting in any of the available scan modes.

Note: Color restoration is not available in Office Mode, if Epson Scan offers that mode.

1. Place your original on your product for scanning.
2. Start Epson Scan.
3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. Locate or access the image adjustment settings.
7. Select the Color Restoration checkbox.

8. When you finish selecting all your settings, click Scan.
9. Click Close to exit the Epson Scan window, if necessary.
Epson Scan scans your original, and saves the color-restored file in the selected folder or opens it in
your scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or OS X Finder, where you can view and print the image, if desired.
Parent topic: Scanning Special Projects
Related tasks
Placing Originals on the Scanner Glass
Starting a Scan Using the Epson Scan Icon
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Selecting the Scan Mode
Selecting Scan File Settings

Scanning to Online Destinations Using Easy Photo Scan
You can scan documents or photos and upload them to Facebook and other online destinations, such as
photo-sharing sites, web servers, or network folders using Easy Photo Scan.
Scanning Using Easy Photo Scan
Uploading Scanned Images to Facebook
Uploading Scanned Images to Picasa
Uploading Scanned Images to Evernote
Uploading Scanned Images to SugarSync
Uploading Scanned Images to a Web Folder
Uploading Scanned Images to Email
Saving Scanned Images to a Folder
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings
Parent topic: Scanning Special Projects

Scanning Using Easy Photo Scan
You can use Easy Photo Scan to easily scan your originals, edit the scanned images, and upload them
to Facebook or other online destinations.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Place your original on your product for scanning.
2. Do one of the following to open Easy Photo Scan:

• Windows 8.x: Navigate to the Apps screen and select Easy Photo Scan. Select your product
and click OK, if necessary.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software and click Easy Photo Scan. Select your product and click OK, if necessary.
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• OS X: Open the Applications folder, click Epson Software, and click Easy Photo Scan. Select
your product and click OK, if necessary.

You see a window like this:

3. Click the Scan icon.
Your scanning program launches.

4. Click Scan in the window that appears to scan your original.
The scanned image is displayed in the Easy Photo Scan window with an automatically generated
name.

Note: You may need to click the Close button to display Easy Photo Scan.

5. To edit the name of the file, select the image thumbnail at the bottom of the screen, click the
icon, and enter the new filename.

6. To edit the scanned image, click the Edit icon and select one of the displayed options.

Note: See the Easy Photo Scan help for additional information on image editing options.
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7. Repeat these steps for each image you want to upload.
8. When you finish scanning, click one of the destination icons to upload the images.

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related tasks
Uploading Scanned Images to Facebook
Uploading Scanned Images to Picasa
Uploading Scanned Images to Evernote
Uploading Scanned Images to SugarSync
Uploading Scanned Images to a Web Folder
Uploading Scanned Images to Email
Saving Scanned Images to a Folder

Uploading Scanned Images to Facebook
You can configure a Facebook account for use with Easy Photo Scan and upload your scanned images
to it.
1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Note: If you have already configured a Facebook account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account, click Login if necessary, and click Send to
upload your images.

3. Click Login.
4. On the Application Authentication screen, log in to your Facebook account.

Note: To enable automatic image uploading, select the option for staying logged in.
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5. Select an album from the Album list.

Note: If you cannot select an album, make sure the Setting Name is set to (No Selection), click
Login to log in to your Facebook account, and try again. If you want to create a new album, you
must create it directly in Facebook.

6. Select the image format for the uploaded files from the File or File Type list.
7. If there are options for the selected file format, click Options or Option and select the options you

want.
8. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder

checkbox and select a folder.
9. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,

and select Save As. Enter a name for the setting and click OK.
10. Click Send to upload the images to your Facebook account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Picasa
You can configure a Picasa account for use with Easy Photo Scan and upload your scanned images.
1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Note: If you have already configured a Picasa account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account, click Login if necessary, and click Send to
upload your images.

3. Click Login.
4. On the Application Authentication screen, log into your Google account.
5. Click Accept to allow Easy Photo Scan to upload images to your account.

An authentication code is generated.
6. Copy the authentication code into the Please enter authentication code field and click OK.
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7. Select an album from the Album list.

Note: If you cannot select an album, make sure the Setting Name is set to (No Selection), click the
Login button to log into your Picasa account, and try again. If you want to create a new album, you
must create it directly in Picasa.

8. Select an Image Size option for the uploaded images.
9. Select the image format for the uploaded files from the File or File Type list.
10. If there are options for the selected file format, click Options or Option and select the options you

want.
11. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder

checkbox and select a folder.
12. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,

and select Save As. Enter a name for the setting and click OK.
13. Click Send to upload the images to your Picasa account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Evernote
You can configure an Evernote account for use with Easy Photo Scan and upload your scanned images
to it (Windows only).

Note: You must install Evernote before you can use it with Easy Photo Scan.

1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Note: If you have already configured an Evernote account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your images.

3. Select a notebook from the Notebook list.

Note: If you want to create a new notebook, you must create it directly in Evernote.

4. Select the image format for the uploaded files from the File or File Type list.
5. If there are options for the selected file format, click Options or Option and select the options you

want.
6. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder

checkbox and select a folder.
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7. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

8. Click Send to upload the images to your Evernote account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to SugarSync
You can configure a SugarSync account for use with Easy Photo Scan and upload your scanned
images.
1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Note: If you have already configured a SugarSync account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your images.

3. Enter the account information in the E-Mail Address and Password fields.
4. Select a Place option for the uploaded images.

Note: In SugarSync, the Magic Briefcase is now called "My SugarSync". Uploads to the Magic
Briefcase appear in the My SugarSync folder.

5. Enter a folder name in the Folder field.
If you enter the name of an existing folder, the images are uploaded to that folder. If the folder does
not exist, a new folder with that name is created.
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6. If you want to replace existing files with the same name with the uploaded images, click the
Overwrite file(s) with the same name checkbox.

7. Click Check Connection to test whether the SugarSync account information is correct.
8. Select the image format for the uploaded files from the File or File Type list.
9. If there are options for the selected file format, click Options or Option and select the options you

want.
10. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder

checkbox and select a folder.
11. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,

and select Save As. Enter a name for the setting and click OK.
12. Click Send to upload the images to your SugarSync account, or click Cancel to cancel the

operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings
Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to a Web Folder
You can upload your scanned images to a Web Folder (WebDAV) using Easy Photo Scan.
1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Note: If you have already configured a Web Folder account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your pictures.

3. Enter the Web Folder URL in the Address field.
4. Enter the login information in the User Name and Password fields.
5. If you want to replace existing files with the same name with the uploaded images, click the

Overwrite file(s) with the same name checkbox.
6. Click Check Connection to test whether the account information is correct.
7. Select the image format for the uploaded files from the File or File Type list.
8. If there are options for the selected file format, click Options or Option and select the options you

want.
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9. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.

10. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

11. Click Send to upload the images to your Web Folder, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings
Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Email
You can save your scanned images to a local network folder and send them by email using Easy Photo
Scan.

Note: With Windows, Easy Photo Scan supports Microsoft Outlook 2000/2002/2003/2007/2010
(x86)/2013 (x86) and Windows Mail/Windows Live Mail. If you do not have one of these email
applications, Easy Photo Scan saves the images, but the email application does not open.

1. Scan your original using Easy Photo Scan.

2. Click the icon.
You see a window like this:
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Note: With OS X, you also enter an email address and email text in the window. If you have already
configured email settings in Easy Photo Scan, you can select them using the Destination Name
field.

3. Select the image format for the saved files from the File or File Type list.
4. If there are options for the selected file format, click Options or Option and select the options you

want.
5. Do one of the following:

• Windows: Click Browse to choose the folder where you want to save the images. Then click OK
to save the images to the folder and launch your email program, or click Cancel to cancel the
operation.

• OS X: If you also want to save the images to a local folder, select the Copy the image(s) to a
local folder checkbox and select a folder. Then click Send, or click Cancel to cancel the
operation.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings
Related tasks
Scanning Using Easy Photo Scan

Saving Scanned Images to a Folder
You can save your scanned images to a local network folder using Easy Photo Scan.
1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

3. Select the image format for the saved files from the File or File Type list.
4. If there are options for the selected file format, click Options and select the options you want.
5. Click Browse or the Save in field to choose the folder where you want to save the images.
6. Click OK to save the images to the folder, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Related references
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings
Related tasks
Scanning Using Easy Photo Scan

Epson JPEG File Settings
You can select from the following settings in the JPEG settings window in Easy Photo Scan.
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Note: The available settings may vary, depending on the operating system you are using.

Setting Description
Image Quality Options Specifies the compression level. The file size

increases with higher quality.
Encoding Specifies the encoding method.

Standard: Images are rendered from the top to the
bottom when displayed on a web browser.
Progressive: Images are rendered in low
resolution in a web browser, then replaced with a
higher resolution.

Embed ICC Profile Allows the ICC profile (information on color
reproducibility of scanned image) to be embedded
in the image. Programs that use color
management software will display the colors of the
image using the ICC profile.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Epson TIFF and Multi-TIFF File Settings

You can select from the following settings in the TIFF settings window in Easy Photo Scan.
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Note: The available settings may vary, depending on the operating system you are using.

Setting Description
Byte Order Specifies the operating system where the scanned

image will be used.
Compression Specifies the compression format and level for

Color/Grayscale and B&W images. The file size
increases with higher quality.

Embed ICC Profile Allows the ICC profile (information on color
reproducibility of scanned image) to be embedded
in the image. Programs that use color
management software will display the colors of the
image using the ICC profile.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
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Using Memory Cards With Your Product
Follow the instructions here to work with a memory card inserted into your product.
Inserting a Memory Card
Printing from a Memory Card
Transferring Photos on a Memory Card

Inserting a Memory Card
Insert only one memory card at a time into a memory card slot on your product.
1. Make sure the memory card and the files on it are compatible with your product before inserting the

card.
2. Open the cover and insert your memory card into the correct slot, making sure the card is oriented

correctly.

1 Memory card access light

Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.

The memory card access light flashes and then stays lit.
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Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

Memory Card Types
Memory Card File Specifications
Removing a Memory Card
Parent topic: Using Memory Cards With Your Product

Memory Card Types
You can insert these types of memory cards in your product.

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

Left Slot
You can insert the following cards in the left slot:
• Memory Stick Duo
• Memory Stick PRO Duo
• Memory Stick PRO-HG Duo
• Memory Stick Micro*
• MagicGate Memory Stick Duo
• SDXC
• SDHC
• SD
• miniSDHC*
• miniSD*
• microSDXC*
• microSDHC*
• microSD*
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Right Slot
You can insert the following cards in the right slot:
• CompactFlash
• Microdrive
Parent topic: Inserting a Memory Card

Memory Card File Specifications
You can insert memory cards in your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
Image size 80 × 80 pixels to 10200 × 10200 pixels
Number of files Up to 9990

Parent topic: Inserting a Memory Card

Removing a Memory Card
After you finish working with a memory card, you can check to make sure it is safe to remove it from your
product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.
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1. Make sure the memory card access light is not flashing.

2. If your product is connected to your computer using a USB cable, do one of the following:
• Windows: Open the My Computer, Computer, Windows Explorer, or File Explorer utility.

Then right-click the name of your memory card (listed as a removable disk) and select Eject.
• OS X: Drag the removable disk icon for your memory card from the desktop or computer window

into the trash.
3. Pull the memory card straight out of its slot.
Parent topic: Inserting a Memory Card

Printing from a Memory Card
See these sections to print photos from a memory card inserted into your product:
Viewing and Printing Photos
Printing Photo Layouts from a Memory Card
Printing Photo Greeting Cards
Parent topic: Using Memory Cards With Your Product

Viewing and Printing Photos
See these sections to view and print photos displayed on your product's LCD screen.
Viewing and Printing Photos From the LCD Screen
Cropping Photos Displayed on the LCD Screen
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Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card
Paper Type Settings - Memory Card
Parent topic: Printing from a Memory Card

Viewing and Printing Photos From the LCD Screen
You can select photos for printing as you view them on the LCD screen.
1. Select Print Photos.

2. Do one of the following to select your photos:
• To select individual photos, select the thumbnail image of the photo you want to print and press

the + button or the – button to select the number of copies (up to 99). Press the left or right arrow
button to scroll through and select additional photos, or press the Back button to return to the
thumbnail image view and select another photo.

• To select all photos, select Options > Select Photos > Select All Photos, then press the +
button or the – button to select the number of copies (up to 99). Select Done when finished.

• To select photos based on the date they were taken, select Options > Browse > Browse by Date
and select any of the dates shown. Select Proceed and select the photos you want to print.

3. To adjust your photos, do either of the following as necessary (adjustments modify only your printed
copy, not the original file):
• To crop, zoom into, or rotate a photo, select the thumbnail image of the photo you want to modify,

select Edit > Crop/Zoom. Make the necessary adjustments, select OK and select OK again.
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• To change the appearance (such as brightness and contrast) of your printed photos, select the
thumbnail image of a photo, select Edit > Photo Adjustments, and select the necessary settings.
When you are finished, press the Back button twice.

4. To change the print settings, select Settings and select the necessary settings. When you are
finished, press the Back button.

5. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Parent topic: Viewing and Printing Photos
Related references
Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card
Related tasks
Cropping Photos Displayed on the LCD Screen

Cropping Photos Displayed on the LCD Screen
If you want to crop or rotate photos displayed on the LCD screen, select the thumbnail image of the
photo you want to modify, select Edit > Crop/Zoom, and select the necessary options.
• To crop the photo, press the + button to move the yellow crop area inward or the – button to move the

crop area outward.
• To move the crop area, use the arrow buttons.
• To rotate the crop area, select .
• To check the cropped image, select OK.
Parent topic: Viewing and Printing Photos

Photo Adjustment Options - Memory Card
Select the Photo Adjustment options you want to use when viewing and printing photos displayed on
the LCD screen. The modifications affect only the printed copy of the photo, not the original file.
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Photo Adjustment Available options Description
settings
Fix Photo Fix Photo Off Turns off automatic adjustments; see Note below

Automatic Optimizes the Fix Photo adjustments for specific
types of photos; select the option that best matchesPeople your photo content

Landscape
Night Scene
P.I.M. Uses your camera's PRINT Image Matching or Exif

Print adjustments
Fix Red-Eye Off - Current Automatically fixes the red-eye effect in photos

On - Current
Off - All Photos
On - All Photos

Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing Photos
Print Setting Options - Memory Card

Select the Print Settings options you want to use when printing photos displayed on the LCD screen.

Print settings Available Description
options

Paper Size Various paper Indicates the size of paper you have loaded
sizes
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Print settings Available Description
options

Paper Type Various paper Indicates the type of paper you have loaded; see the list of
types paper types for memory card (available options depend on

the selected Paper Size setting)
Paper Source Cassette 1 Prints onto paper loaded in Cassette 1 (upper cassette)

Cassette 2 Prints onto paper loaded in Cassette 2 (lower cassette)
Cassette Prints onto paper loaded in Cassette 1 and then onto paper
1>Cassette 2 loaded in Cassette 2 when the first cassette is empty (load

the same size and type of paper in both cassettes when
selecting this option)

Rear Paper Prints onto paper loaded in the rear paper feed slot
Feed Slot

Borderless Borderless Expands the image to the edge of the paper (slight cropping
may occur)

With Border Leaves a small margin around the image
Quality Draft Provides lower quality for draft printing

Standard Provides good quality for most prints
Best Provides the highest quality for important prints

Expansion Standard Expands images correctly for most borderless prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints (you may see

some white border)
Date Various date Prints the date the photo was taken on the photo in the

formats format you select
Print Info. On Camera Prints settings that you added in your camera
Photos Settings

Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo by cameras

that have a built-in GPS feature
Off Turns off printing info from your camera
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Print settings Available Description
options

Fit Frame On Automatically crops the photo to fit into the selected photo
layout

Off Turns off automatic cropping
Bidirectional On Prints at normal speed

Off Slows down printing to improve print quality
Clear All Settings Yes Clears all print settings

No

Parent topic: Viewing and Printing Photos
Related references
Paper Type Settings - Memory Card

Paper Type Settings - Memory Card
Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper
Epson Bright White Paper
Epson Presentation Paper Matte
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets
Epson Premium Presentation Paper Matte Prem. Matte
Epson Premium Presentation Paper Matte Double-sided Presentation Matte
Epson Ultra Premium Presentation Paper Matte
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Ultra Premium Photo Paper Luster
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Ultra Premium Photo Paper Glossy Ultra Glossy
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Paper type loaded Paper Type setting
Epson Photo Paper Glossy Glossy
Epson Velvet Fine Art Paper Velvet Fine Art Paper

Parent topic: Viewing and Printing Photos

Printing Photo Layouts from a Memory Card
You can print one or more photos from a memory card in special layouts on various sizes of photo paper.

1. Press the home button, if necessary.
2. Select More Functions.
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3. Select Photo Layout Sheet.

4. Scroll down to view all of the layout options, then select the option you want.
5. Select the paper size and paper type that matches the paper you loaded and select Proceed.
6. If you see a screen asking you to choose between automatic and manual placement of photos, do

one of the following:
• Select Automatic layout if you want to allow your product to place the photos in the layout

automatically.
• Select Place photos manually to place photos in the layout manually.

7. Select the photos you want to print and select Proceed. If you chose to place the photos manually,
follow the instructions on the LCD screen to select and place your photos on the layout, then select
Proceed.

8. Press the + or – button to select the number of layout sheets to print (up to 99) and select Proceed.
9. Select additional print settings for your layout as necessary.
10. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Photo Layout Options
Parent topic: Printing from a Memory Card
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Photo Layout Options
Select the layout you want to use when printing your photos in a layout.
Picture Package

Prints one photo in multiple sizes on one sheet.
2-up, 4-up, 8-up, or 20-up

Print 2, 4, 8, or 20 photos on one sheet.
Upper ½ or Lower ½

Print one photo in the upper or lower half of the sheet.
Photo ID

Prints 4 ID-sized photos on one sheet.
Jewel Upper

Prints one photo on the upper half of a folded jewel case insert.
Jewel Index

Prints 24 to 48 thumbnail images on a folded jewel case insert.
Parent topic: Printing Photo Layouts from a Memory Card

Printing Photo Greeting Cards
You can create custom greeting cards using photos on your memory card or other device, and add your
own handwritten or printed text.
First you select your photo and print a template on plain paper. Then you fill out the template, add your
message, and print your cards.
Creating and Printing a Greeting Card Template
Printing a Greeting Card from a Template
Parent topic: Printing from a Memory Card

Creating and Printing a Greeting Card Template
Before you start, make sure plain paper is loaded and your memory card is inserted.

1. Press the home button, if necessary.
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2. Select More Functions.

3. Select Greeting Card.

4. Select Select Photo and Print Template.

5. Select the photo you want and select Proceed home.
6. Select Paper Size and select Letter to print three cards on one letter-size sheet or 4x6in to print one

card.
7. Select Paper Type and select the type of paper you plan to use.
8. Select the other print settings as necessary and select Proceed.
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9. When you are ready to print your greeting card template on plain paper, press the Start button.
Parent topic: Printing Photo Greeting Cards
Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing a Greeting Card from a Template
After your greeting card template is printed, you fill it out to create your card and add your message.
1. Use a dark pen or pencil to fill in the circles and select the Text Style and Text Effects.

2. Add your greeting card message within the box. You can write it in by hand, print a message and
paste it into the box, or draw a picture.

Tip: When adding text, place it in the direction that your photo faces.

3. Load photo paper either in Cassette 2 (lower) for this size: Letter (8.5 × 11 inches [216 × 279 mm]),
or in Cassette 1 (upper) for this size: 4 × 6 inches (102 × 152 mm).

4. Select Print Greeting Cards from Template. (If you do not see this option, press the home
button and select More Functions > Greeting Card > Print Greeting Cards from Template.)

5. Follow the instructions on the LCD screen to place the template facedown on the scanner glass, with
the blue triangle facing into the front right corner.
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6. Close the document cover and select Proceed.
7. To print more than one copy, press the + or – button to select the number (up to 99).
8. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

When you finish printing, cut your greeting cards apart, if necessary.
Parent topic: Printing Photo Greeting Cards
Related tasks
Creating and Printing a Greeting Card Template

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.
Setting Up File Sharing for Photo Transfers From Your Computer
Transferring Photos from a Memory Card to Your Computer
Parent topic: Using Memory Cards With Your Product

Setting Up File Sharing for Photo Transfers From Your Computer
Before you transfer photos from a computer to a memory card inserted into a memory card slot on your
product, you may need to set up your product's file sharing settings.
1. Remove any memory cards from the product.

Caution: Remove the memory card before you change the file sharing settings or you may lose data
from the memory card. Do not remove a memory card or turn off your product while the memory card
access light is flashing or you may lose data from the memory card.

2. Press the home button, if necessary.
3. Select Setup.
4. Scroll down and select File Sharing Setup.
5. Select the connection type between the printer and your computer.
Parent topic: Transferring Photos on a Memory Card

201



Related tasks
Removing a Memory Card

Transferring Photos from a Memory Card to Your Computer
You can transfer photos to and from a memory card inserted into a memory card slot on your product
and a computer connected to your product.

Note: Do not transfer photos to and from a memory card while you are printing from the memory card.

1. Make sure your product is connected to a computer.
2. Insert a memory card into a memory card slot on your product.
3. Do one of the following to access your memory card files from your computer:

• Windows: Open the Computer, My Computer, Windows Explorer, or File Explorer utility, then
select the removable disk icon.

• OS X with a USB connection: Look for the removable disk icon on your desktop or computer
window, then select it.

• OS X with a network connection: Select the hard drive icon on your desktop or computer
window, select your product in the SHARED section of the sidebar (you may need to widen the
sidebar to see the name), then select the MEMORYCARD icon.

4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

Note: Your product's LCD screen does not update to display new photos transferred to the memory
card. Wait until the memory card access light stops flashing, then remove and insert the memory card to
update the photos displayed.

Parent topic: Transferring Photos on a Memory Card
Related tasks
Inserting a Memory Card
Removing a Memory Card
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Using an External Device with Your Product
Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.
Printing from a Camera
Viewing or Printing from a USB Flash Drive or External Device

Printing from a Camera
If you have a digital camera that supports PictBridge printing, you can print your photos directly from the
camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 × 80 to 10200 × 10200 pixels. Epson
cannot guarantee the compatibility of your camera. Some combinations of paper type, size, and layout
may not be supported, depending on your camera and the product settings.

Selecting Print and Photo Adjustment Settings
Connecting and Printing from a Camera
Printing from a Camera Wirelessly
Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings
Before printing from your camera, you can make image adjustments and select the print settings for your
photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Press the home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

3. Scroll down and select External Device Setup.
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4. Select Print Settings.

5. Select the print settings you want to use.
6. When you are done, press the Back button.
7. Select Photo Adjustments.

8. Select the photo adjustments you want to use. Press the home button to exit.
After you select settings, you are ready to connect your camera and print your photos.
Print Settings - Camera
Photo Adjustments - Camera
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Parent topic: Printing from a Camera
Print Settings - Camera

Select the Print Settings options you want to use when printing photos from your camera.

Print settings Available options Description
Paper Size Various paper sizes Indicates the size of paper you have loaded
Paper Type Various paper types Indicates the type of paper you have loaded; see

the list of paper types for copying (available
options depend on the selected Paper Size
setting)

Paper Source Cassette 1 Prints onto paper loaded in Cassette 1 (upper
cassette)

Cassette 2 Prints onto paper loaded in Cassette 2 (lower
cassette)

Cassette 1> Cassette 2 Prints onto paper loaded in Cassette 1 and then
onto paper loaded in Cassette 2 when the first
cassette is empty (load the same size and type of
paper in both cassettes when selecting this
option)

Rear Paper Feed Slot Prints onto paper loaded in the rear paper feed
slot
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Print settings Available options Description
Layout Borderless Expands the image to the edge of the paper (slight

cropping may occur)
With Border Leaves a small margin around the image
Picture Package Prints one photo in multiple sizes on one sheet
2-up, 4-up, 8-up, 20-up, 30- Prints the selected number of photos on one sheet
up, or 80-up or CD/DVD
Photo ID Prints 4 ID-sized photos on one sheet
Upper ½ or Lower ½ Print one photo in the upper or lower half of the

sheet
Jewel Upper Prints one photo on the upper half of a folded

jewel case insert
Jewel Index Prints 24 to 48 thumbnail images on a folded jewel

case insert
Quality Draft Provides lower quality for draft printing

Standard Provides good quality for most prints
Best Provides the highest quality for important prints

Expansion Standard Expands images correctly for most borderless
prints

Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints

(you may see some white border)
Date Off Does not print the date on which the photo was

taken
On Prints the date on which the photo was taken
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Print settings Available options Description
Print Info. On Off Turns off printing info from your camera
Photos Camera Settings Prints your camera's shutter speed, aperture, and

ISO speed
Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo

by cameras that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the

selected photo layout
Off Turns off automatic cropping

Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

CD Inner/Outer Range of measurements Selects inner and outer diameter for printing on
CDs/DVDs from your camera

CD Density Standard Adjusts the print density when printing on
CDs/DVDs from your cameraDarker

Darkest
Clear All Settings Yes Clears all print settings

No

Parent topic: Selecting Print and Photo Adjustment Settings
Related references
Paper Type Settings - Copying

Photo Adjustments - Camera
Select the Photo Adjustments options you want to use when printing photos from your camera. The
modifications affect only the printed copy of the photo, not the original file.
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Photo Available options Description
Adjustments
settings
Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene Detection
setting that is selected

Fix Photo Off Turns off automatic adjustments; see Note below
P.I.M Uses your camera's PRINT Image Matching or Exif Print

adjustments
Scene Detection Automatic Optimizes the Fix Photo adjustments for specific types of

photos; select the option that best matches your photoPeople content
Landscape
Night Scene

Fix Red-Eye Off Does not automatically fix the red-eye effect in photos
On Automatically fixes the red-eye effect in photos

Filter Off Turns off the filter setting
Sepia Applies a sepia tone filter to the viewed or printed photo
B&W Applies a black-and-white filter to the viewed or printed

photo
Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation
Clear All Yes Clears all photo adjustment settings
Settings No

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.
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Parent topic: Selecting Print and Photo Adjustment Settings

Connecting and Printing from a Camera
Before you connect your camera, make sure the product is turned on but not printing.
1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Connect the USB cable that came with your camera to the USB port on the front of your product.

Note: You cannot use the USB port to transfer images from your camera to your computer.

4. Turn on your camera.
5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Printing from a Camera
Related tasks
Removing a Memory Card
Related topics
Loading Paper

Printing from a Camera Wirelessly
You can print photos from a digital camera using a wireless connection. Make sure your digital camera
can connect to a network and is PictBridge compatible (DPS over IP).
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1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Turn on your camera.
4. Setup the camera's wireless network connection. See the documentation that came with your

camera for details.

Note: Make sure the camera is connected to the same network as the product. You can print a
Network Status sheet to view your product's network settings.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the network.
Parent topic: Printing from a Camera
Related tasks
Removing a Memory Card
Printing a Network Status Sheet
Related topics
Loading Paper

Viewing or Printing from a USB Flash Drive or External Device
You can view and print photos from a USB thumb drive or other external storage device, such as an
external hard drive or CD/DVD burner.

Note: Make sure the files on your device are compatible with the product.

USB Device File Specifications
Connecting and Using a USB Flash Drive or External Device
Parent topic: Using an External Device with Your Product
Related tasks
Removing a Memory Card
Viewing and Printing Photos From the LCD Screen
Related topics
Loading Paper
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USB Device File Specifications
You can print external device files that meet these specifications.

File format JPEG with the Exif version 2.3 standard (taken with digital camera
using DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant)

Image size 80 × 80 pixels to 10200 × 10200 pixels
File size Up to 2GB
Number of files Up to 9990

Note: DCF 2.0 files stored in a camera's built-in memory are not supported.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Connecting and Using a USB Flash Drive or External Device
Before you connect your thumb drive or device, make sure the product is turned on but not printing.

Note: Epson cannot guarantee the compatibility of your drive.

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Insert your USB thumb drive or the USB cable that came with your device into the USB port on

the front of your product.
4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.
When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
Related tasks
Removing a Memory Card
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Related topics
Loading Paper
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Printing Personalized Projects
You can print calendars, lined paper, graph paper, or stationery with a photo background.
Printing Coloring Book Pages
Printing Personalized Note Paper
Printing Lined Paper, Graph Paper, and Music Sheets
Printing Calendar Pages

Printing Coloring Book Pages
You can create a coloring book page from a photo on your memory card, or from a photo or drawing
placed on the scanner glass.
1. Load one of these types of paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7

inches [210 × 297 mm]) size:
• Plain paper
• Epson Bright White Paper
• Epson Presentation Paper Matte
• Epson Premium Presentation Paper Matte
• Epson Velvet Fine Art Paper (letter-size only)

2. Press the home button, if necessary.
3. Select More Functions.
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4. Scroll down and select Coloring Book.

5. Do one of the following:
• Select Photo or Drawing on Scanner Glass to print a design from an original placed facedown

on the scanner glass, in the front right corner.
• Select Photo on Memory Card to print a design from a memory card inserted in your product,

then select a photo.
6. Select Proceed.
7. Select Paper Settings and select the size and type of paper that you loaded.
8. Select Paper Source and select where you loaded your paper.
9. If necessary, adjust the following settings:

• Density to make the print lighter or darker
• Line Detection to change the amount of detail in the print

10. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related tasks
Inserting a Memory Card
Placing Originals on the Scanner Glass
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Related topics
Loading Paper

Printing Personalized Note Paper
You can print lined or unlined note paper with one of your own photos in the background.
1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches

[210 × 297 mm]) size.
2. Insert a memory card into your product's memory card slot.

3. Press the home button, if necessary.
4. Select More Functions.

5. Scroll down and select Personal Stationery.
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6. Select Writing Papers.

7. Scroll down and select one of the following settings:
• Horizontal Rule
• Vertical Rule
• Without Rule

Note: View the thumbnails next to each option to preview the design layout.

8. Select the size of paper you loaded.
9. Select the photo you want to use for your note paper and select Proceed.

Note: To rotate the layout, select Rotate.

10. When you see a message asking you to load paper, select Proceed.
11. To print more than one sheet, press the + or – button to select the number (up to 99).
12. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
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Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing Lined Paper, Graph Paper, and Music Sheets
You can print wide-rule or narrow-rule notebook paper and graph paper.
1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches

[210 × 297 mm]) size.

2. Press the home button, if necessary.
3. Select More Functions.

4. Scroll down and select Personal Stationery.

218



5. Select Lined Papers.

6. Select one of the following settings:
• Wide Rule
• Thin Rule
• Graph Rule
• Music Paper

Note: View the thumbnails next to each option to preview the design layout.

7. Select the size of paper you loaded.
8. When you see a message asking you to load paper, select Proceed.
9. To print more than one sheet, press the + or – button to select the number (up to 99).
10. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related topics
Loading Paper
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Printing Calendar Pages
You can create and print a weekly or monthly calendar page from your product.
1. Load paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches

[210 × 297 mm]) size.

2. Press the home button, if necessary.
3. Select More Functions.

4. Scroll down and select Personal Stationery.
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5. Select Calendar.
6. Select one of the following settings:

• Weekly: prints a Sunday to Saturday week-long calendar with hourly divisions.
• Monthly: prints a monthly calendar for a chosen month and year.
• Monthly with Phioto: prints a monthly calendar for a chosen month and year with a photo in the

background.

Note: View the thumbnails next to each option to preview the design layout.

7. If you choose Monthly, enter the year and month and press Done.
8. Select the type and size of paper to print on.
9. When you see a message asking you to load paper, select Proceed.
10. To print more than one sheet, press the + or – button to select the number (up to 99).
11. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related topics
Loading Paper
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Printing on CDs/DVDs
Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
CD/DVD Printing Features
Loading a CD/DVD
Removing a Printed CD/DVD
Placing a CD/DVD on the Scanner Glass
Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card
Printing on CDs/DVDs from a Computer

CD/DVD Printing Features
You can use any of the following features to print custom CD/DVD/Blu-ray Disc labels and accessories:
• Copy an existing label onto a new CD/DVD/Blu-ray Disc
• Use your product's control panel to print photos from a memory card onto a CD/DVD/Blu-ray Disc
• Print text and images from your computer using the Epson Print CD software
You can also use your product's control panel to create a jewel case insert with photos from a memory
card.
Parent topic: Printing on CDs/DVDs
Related tasks
Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card

Loading a CD/DVD
You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do not insert the CD/DVD tray while the product is printing, copying, or performing other
operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty
or scratched.
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Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the control panel or Epson Print CD
software.

1. Burn your files, music, or video onto your disc before printing on it.
2. Send print data from a computer, or use the control panel to print on the CD/DVD, and follow the on-

screen instructions.
3. Raise the control panel all the way up.

4. Make sure nothing is on the output tray, then close it.

5. Close the front cover.
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6. Remove the CD/DVD tray from the bottom of the product.

7. Place a CD or DVD on the CD/DVD tray with the printable side faceup, and insert the tray into the
slot above the output tray.

Note: Make sure the marks on the tray and the marks on the product line up.

8. Select Ready > OK on the touch panel.

Note: The CD/DVD tray ejects automatically after a certain period of time.

Caution: Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.
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Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD
After your CD or DVD is printed, the tray extends automatically.
1. Pull the CD/DVD tray out of the product and remove your CD or DVD from the tray.

2. Insert the CD/DVD tray into the storage slot on the bottom of the product.

After printing, handle the CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully
before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from
moisture and direct sunlight.
Parent topic: Printing on CDs/DVDs
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Placing a CD/DVD on the Scanner Glass
You can place a CD or DVD on the scanner glass and copy the label design onto another CD or DVD.
1. Open the document cover.
2. Place your CD or DVD facedown in the center of the scanner glass.

3. Close the document cover gently to keep your disc in place.
Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD
You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want,
you can first print a test design on plain paper.
1. Load the CD, DVD, or plain paper you want to print on.

2. Press the home button, if necessary.
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3. Select More Functions.

4. Select CD/DVD Copy.
5. Follow the instructions on the LCD screen to place your original CD, DVD, or photo on the scanner

glass and select Proceed.
6. If necessary, adjust the inner and outer diameter of your CD as shown on the screen and select

Proceed.
You see this screen:

7. Select one of the options shown on the screen to print on a CD or DVD or a test print on plain paper.
If printing on plain paper, select Proceed.
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8. When you are ready to print, press the Start button.

Note: To cancel copying, select Cancel.

Parent topic: Printing on CDs/DVDs
Related tasks
Loading a CD/DVD
Placing a CD/DVD on the Scanner Glass
Placing Originals on the Scanner Glass
Related topics
Loading Paper

Printing Photos from a Memory Card Onto a CD/DVD
You can print one or more photos from a memory card directly onto a CD or DVD. If you want, you can
first print a test design on plain paper.
1. Insert a memory card into a memory card slot on your product.
2. Load the CD, DVD, or plain paper you want to print on.

3. Press the home button, if necessary.
4. Select More Functions.
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5. Select Print on CD/DVD.

6. Select a layout and select Proceed.
7. Follow the instructions on the screen to select your photo or photos.
8. When you see the screen to adjust the inner and outer diameter of your CD, adjust the settings if

necessary and select Proceed.
You see this screen:

9. Select one of the options shown on the screen to print on a CD or DVD or a test print on plain paper.
If printing on plain paper, select Proceed.
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10. Adjust the CD Density setting if necessary, then press the Start button to print.

Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs
Related tasks
Inserting a Memory Card
Loading a CD/DVD
Related topics
Loading Paper

Printing a Jewel Case Insert from a Memory Card
You can print a photo from a memory card, automatically sized to fit on a CD or DVD jewel case insert.
You can also print thumbnail images formatted to fit on a jewel case insert. After the insert is printed, you
can cut and fold it to fit.
1. Insert a memory card into a memory card slot on your product.
2. Load the paper you want to print on.

3. Press the home button, if necessary.
4. Select More Functions.
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5. Select Photo Layout Sheet.

6. Scroll down and then select one of the following:
• Jewel Upper to print one photo on the upper half of the insert.
• Jewel Index to print 24 or 48 thumbnail images on the insert.

7. Select your paper size and type and select Proceed.
8. Follow the instructions on the LCD display to select your photos and set the number of copies.
9. When you see the Print Settings screen, change your print settings if necessary.
10. When you are ready to print, press the Start button.

Note: To cancel printing, select Cancel.

11. Cut and fold your insert following the crop lines.
Parent topic: Printing on CDs/DVDs
Related tasks
Inserting a Memory Card
Related topics
Loading Paper
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Printing on CDs/DVDs from a Computer
Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as
described on the Start Here sheet, and installed the Epson Print CD software.
Starting Epson Print CD - Windows
Printing Your CD/DVD Design - Windows
Starting Epson Print CD - OS X
Printing Your CD/DVD Design - OS X
Parent topic: Printing on CDs/DVDs
Related tasks
Loading a CD/DVD

Starting Epson Print CD - Windows
You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.
1. Select the Epson Print CD icon on your Windows Desktop.

You see a screen like this:
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2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on CDs/DVDs from a Computer

Printing Your CD/DVD Design - Windows
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in Epson Print CD and click Print.

You see a screen like this:

2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, click Test Print and follow the

instructions on the screen.
4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.
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Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer

Starting Epson Print CD - OS X
You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.
1. Open the Epson Print CD program in the Applications > Epson Software > Print CD folder on your

Mac.
You see a screen like this:

2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic
elements.

3. When you are finished creating your design, make sure you save it.
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Parent topic: Printing on CDs/DVDs from a Computer

Printing Your CD/DVD Design - OS X
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in Epson Print CD and select Print from the File menu.

You see a screen like this:

2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, select Test Print and follow the

instructions on the screen.
4. When you are ready to print on the disc, click the Print button on the screen.

Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer
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Replacing Ink Cartridges
When an ink cartridge is expended, you need to replace it.
You may also need to replace a cartridge that is more than six months old, or if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to epson.com/recycle for more information.

Check Cartridge Status
Purchase Epson Ink Cartridges
Removing and Installing Ink Cartridges
Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Check Cartridge Status
Your product and its printing software will let you know when an ink cartridge is low or expended.
Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with OS X
Parent topic: Replacing Ink Cartridges

Checking Cartridge Status on the LCD Screen
You can check the status of your ink cartridges using your product's LCD screen.

1. Press the home button, if necessary.
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2. Select Setup.

3. Select Ink Levels.
The ink cartridge status is displayed.

Note: Displayed ink levels are approximate.

4. Select OK to exit.
Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Windows
A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.
1. To check your cartridge status, access the Windows Desktop and double-click the product icon in

the Windows taskbar.
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You see this window:

2. Replace or reinstall any ink cartridge indicated on the screen.

Note: Depending on the color of the expended cartridge and how you are printing, you may be able
to continue printing temporarily.

Note: If any of the cartridges installed in the product are broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges
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Checking Cartridge Status with OS X
You can check your cartridge status using a utility on your Mac.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see a window like this:
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3. Do the following as necessary:
• To update the ink cartridge status, click Update.
• Replace or reinstall any ink cartridge indicated on the screen.

Note: Depending on the color of the expended cartridge and how you are printing, you may be able
to continue printing temporarily.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges
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Purchase Epson Ink Cartridges
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Standard-capacity High-capacity

Photo Black (PBK) 277 277XL
Black (BK) 277 277XL
Cyan 277 277XL
Magenta 277 277XL
Yellow 277 277XL

Parent topic: Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges
Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.
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Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Make sure that the CD/DVD tray is not inserted for printing.
2. Turn on your product.

• If an ink cartridge is expended, you see a message on the LCD screen. Note which cartridges
need to be replaced and select Proceed. Then choose Yes, replace now.

• If you are replacing a cartridge before you see a message on the LCD screen, select Setup >
Maintenance > Ink Cartridges Replacement.

3. Lift up the scanner unit.

Caution: Do not move the print head by hand; otherwise, you may damage your product. Do not
touch the flat white cable inside the printer.
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4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink
cartridge to remove it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.

5. Recap the used ink cartridge using the cap that came with it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
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6. Remove the new ink cartridge from the package.

Caution: Do not shake the cartridges after opening the packages, or ink may leak. Do not touch the
areas shown above. Doing so may prevent normal operation and printing.

7. Remove the cap from the cartridge and store it for later use.

Note: Save the cap so you can recap ink cartridges before storing or disposing of them.

Caution: Do not remove any other labels or seals, or ink will leak.

245



8. Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom of the ink
cartridge down until it clicks into place.

9. Once you replace all the cartridges that need replacing, close the scanner unit.

The product starts charging the ink. This takes a few minutes. When you see a completion message
on the LCD screen, ink replacement is complete.

Note: Do not turn off the product while it is charging or you will waste ink. If you see an error screen
telling you an ink cartridge is installed incorrectly, lift up the scanner unit and press the ink cartridge
down until it clicks into place. When you're finished, close the scanner unit.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

Caution: If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came
with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
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cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges
Related concepts
Purchase Epson Ink Cartridges

Printing with Black Ink and Expended Color Cartridges
When a color or photo black ink cartridge is expended, you can temporarily continue printing from your
computer using black ink. Replace the expended cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - OS X
Parent topic: Replacing Ink Cartridges
Related tasks
Removing and Installing Ink Cartridges

Printing with Expended Color Cartridges - Windows
If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.

1. Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the Main tab.
5. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
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6. Select the Black/Grayscale checkbox.
7. Click OK.
8. Print your document.

Epson Status Monitor 3 displays a print message.
9. Click Print in Black to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges
Related topics
Loading Paper

Printing with Expended Color Cartridges - OS X
If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.
1. Click the printer icon in the Dock.
2. If you see a message telling you that you can temporarily print with only black ink, click the Delete or

button to cancel your print job. If you see an error message, click OK.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

3. In the Apple menu or the Dock, select System Preferences.
4. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
5. Select Driver or Options.
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You see a screen like this:

6. Select On as the Permit temporary black printing setting.
7. Click OK.
8. Close the utility window.
9. Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
11. Select Print Settings from the pop-up menu.
12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.
14. Click Print to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges
Related topics
Loading Paper
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Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

• Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

• Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to replace the ink cartridges.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and

the output tray is extended.
2. Load a few sheets of plain paper in the product.
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3. Press the home button, if necessary.
4. Select Setup.
5. Select Maintenance.

6. Select Nozzle Check.

7. Press the Start button.
The nozzle check pattern is printed.
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8. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

9. Do one of the following:
• If there are no gaps, the print head is clean. Select Done.
• If there are gaps or the pattern is faint, select Clean the Print Head.

10. Follow the instructions on the screen to clean the print head.
If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Nozzle Check
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Cleaning the Print Head Using the Product Control Panel
Related topics
Replacing Ink Cartridges

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
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1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
• OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &

Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
You see a window like this:

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Cleaning the Print Head Using a Computer Utility
Related topics
Replacing Ink Cartridges

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.
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Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and

the output tray is extended.
2. Load a few sheets of plain paper in the product.

3. Press the home button, if necessary.
4. Select Setup.
5. Select Maintenance.
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6. Select Head Cleaning.

7. Press the Start button to clean the print head. You see a message on the LCD screen during the
cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

When the cleaning cycle is finished, you see a message on the display screen.
8. Select Print Nozzle Check Pattern, then press the Start button to run a nozzle check and

confirm that the print head is clean.
If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Checking the Nozzles Using the Product Control Panel
Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows computer or Mac.
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1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &

Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
You see a window like this:

5. Click Start to begin the cleaning cycle.
You see a message on the LCD screen during the cleaning cycle.
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Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Checking the Nozzles Using a Computer Utility
Related topics
Replacing Ink Cartridges
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Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and

the output tray is extended.
2. Load a few sheets of plain paper in the product.

3. Press the home button, if necessary.
4. Select Setup.
5. Select Maintenance.
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6. Select Print Head Alignment.

7. Press the Start button to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the best printed pattern for each set.
9. Select Done when you are finished.
Parent topic: Print Head Alignment
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows or Mac computer.
1. Make sure the CD/DVD tray is not inserted for printing. Make sure there are no errors on the LCD

screen, the CD/DVD tray is not inserted for printing, and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
• OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &

Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.
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4. Select Print Head Alignment.
5. Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:

6. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.
• After choosing a pattern number, click Next.
• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click

Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
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Parent topic: Print Head Alignment
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)

Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

Caution: Do not use tissues to clean the rollers inside the product; lint from tissue may clog the print
head nozzles.

1. Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.

Note: Make sure there is no dust or stains on the scanner glass or document cover.

3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.
Close the output tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a

little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
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• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

• Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Lift up the scanner unit and check to see if the print head is in the far right position (the home

position). If not, turn on the product, wait for the print head to move, then turn the product off again.
3. Secure the ink cartridge holder to the case with tape.

Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
your product.

4. Lower the scanner unit.
5. Remove all the paper from the product.
6. Remove any memory cards inserted in the product.
7. Unplug the power cable.
8. Disconnect any connected cables.
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9. Close the rear paper feed slot cover and the output tray. Then lower the control panel.

10. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder
before turning on your product. If print quality has declined when you print again, clean and align the
print head.
Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Memory Card Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
You can select Download the Latest Software from the Home screen of this manual or visit Epson's
driver download site (U.S. downloads or Canadian downloads).
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:
• Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
• On the Maintenance tab in the printer settings window
You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.
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Parent topic: Solving Problems
Related tasks
Changing Automatic Update Options

Product Status Messages
You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also see help information and how-to instructions on the screen. Press the home button, if
necessary, press the left or right arrow button, and then select Help.

LCD screen message Condition/solution
Paper jam Paper is jammed in the product. Follow the instructions on the LCD screen to

remove the jammed paper from the indicated area.
Paper out No paper is loaded. Load paper in the product.
Photos not recognized. There is a problem with originals placed on the product. Check to make sure
Place the photos they are placed correctly and repeat the operation.
correctly on the scanner
glass.
Printer error. Turn the A fatal error has occurred. Turn the product off and then back on again. If the
power off and on again. error continues, check for a paper jam. If there is no paper jam, contact
For details, see your Epson for support.
documentation.
Communication error. Make sure the computer is connected to your product and your scanning
Check if a computer is software is installed correctly.
connected.
A printer's ink pad is The ink pads are near the end of their service life and the message will be
nearing the end of its displayed until the ink pad is replaced. Contact Epson for support. (To
service life. Contact resume printing, press the Start button.)
Epson Support.
A printer's ink pad is at The ink pad is at the end of its service life. Turn off the product and contact
the end of its service life. Epson for support.
Contact Epson Support.
Memory card or external Make sure the memory card or external device is inserted correctly and
device not recognized. meets the specifications for your product.
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LCD screen message Condition/solution
Combination of IP There is a problem with the network connection to your product.
address and subnet
mask is invalid. See
your documentation.
Recovery mode An error has occurred during firmware updating. Connect your product using

a USB cable and try downloading the Firmware Update from Epson's support
website. If you still need help, contact Epson for support.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD, or lights on the control panel will advise you when these parts need replacing. If this happens
during the standard warranty of the product, the exchange of the product or replacement of the pads is
covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any
Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer or Rear Cover
Where to Get Help
Related tasks
Placing Originals on the Scanner Glass
Related topics
Solving Network Problems

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.

3. Press the home button, if necessary.
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4. Select Setup.
5. Select Maintenance.

6. Select Nozzle Check.

7. Press the Start button.
The nozzle check pattern is printed.

8. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Uninstall Your Product Software
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select Restore Default Settings.
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4. Select one of these options:
• Wi-Fi/Network Settings: Resets all network settings.
• All except Wi-Fi/Network Settings: Resets all control panel settings, except for network settings.
• All Settings: Resets all control panel settings.
You see a confirmation screen.

5. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Noise After Ink Installation
Software Installation Problems
Control Panel Setup Problems
Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:
• The first time you install ink cartridges, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related references
Where to Get Help

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.
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• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
OS X System Requirements

Control Panel Setup Problems
If you have problems setting up the control panel, try these solutions:
• To view LCD screen text in a different language, select a different language setting for the panel.
• To adjust the position of the control panel, carefully raise or lower it.
Parent topic: Solving Setup Problems
Related tasks
Adjusting Control Panel Position
Changing LCD Screen Language

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in OS X Printer Window
Cannot Print Over a Network
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Cannot Scan Over a Network
Parent topic: Solving Problems
Related tasks
Printing a Network Status Sheet

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.
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• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Related tasks
Printing a Network Status Sheet
Enabling Wi-Fi Direct Mode

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify connection using your

product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-

ASCII characters.
• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:

1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
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Related tasks
Resetting Control Panel Defaults

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD is not lit, make sure you select one of the WPS options from the product control panel
within 2 minutes of pressing the WPS button on your router.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear lit
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.
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Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD is not lit, make sure you select one of the WPS options from the product control panel
within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:
• Make sure the Ethernet cable is securely connected to your product and to your router, access

point, switch, or hub.
• Try connecting your product to a different port or a different router, access point, switch, or hub.
• Try connecting with a different Ethernet cable.
• Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Printing a Network Status Sheet

Cannot Scan Over a Network
If you cannot start Epson Scan for scanning over a network, try these solutions:
• If you cannot scan from your product control panel, make sure you restarted your computer after

installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.
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Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few
seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan again.

• Check the connection setting and test the connection using Epson Scan Settings:
Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the Connection setting is set to Network, then click the
Test button.
OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the Connection setting is set to Network, then click the Test button.

• Make sure the option selected as the Timeout Setting in the Epson Scan Settings program is long
enough to complete scanning over a network.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Parent topic: Solving Problems
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Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust

the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette. Make sure to load only one sheet at a time in the rear feed slot.

• Be sure to insert the paper cassette all the way into your product.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• Make sure your paper meets the specifications for your product.
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• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
Related references
Paper Loading Capacity
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer or Rear Cover

Paper Jam Problems Inside the Product
If you see a message that paper has jammed inside the product, follow the steps here or on the LCD
screen to clear the jam.
1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
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3. Lift the scanner unit and remove any jammed paper inside.

Caution: Do not touch the flat white cable inside the printer.

4. Close the scanner unit.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer or Rear Cover
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Paper Jam Problems in the Paper Cassette
If you see a message that paper has jammed in the paper cassette, follow the steps here or on the LCD
screen to clear the jam.
1. Cancel the print job, if necessary.
2. Pull out both paper cassettes, then carefully remove any jammed paper.

3. Make sure the paper you loaded is under the edge guides.
4. Keep the cassette flat as you insert it. If inserting Cassette 1 (upper cassette), insert it until the arrows

on the right side line up.
5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Auto Duplexer or Rear Cover

Paper Jam Problems in the Auto Duplexer or Rear Cover
If you see a message that paper has jammed in the auto duplexer or rear cover, follow the steps here or
on the LCD screen to clear the jam.
1. Cancel the print job, if necessary.
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2. Press the buttons to release the auto duplexer and remove it from your product. Carefully remove any
jammed paper from inside the product.

3. Remove any jammed paper from the duplexer.
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4. Open the duplexer and remove any jammed paper from inside it.

5. Reattach the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
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Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
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• Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

• In Windows, make sure your product is selected as the default printer.
• In Windows, clear any stalled print jobs from the Windows Spooler:

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select See what's printing, and select your
product name again if necessary. Right-click the stalled print job, click Cancel, and click Yes.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.

• Windows 7: Click and select Devices and Printers.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select

Printers and Other Hardware, if necessary, and Printers and Faxes.)
2. Right-click your product name, select Printing Preferences, and select your product name again if

necessary.
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3. Click the Maintenance tab.
4. Click the Extended Settings button.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement
If you see an error light or error message after you replace an ink cartridge, follow these steps:
1. Make sure the print head is in the ink cartridge replacement position.

Note: If the print head is not in the ink cartridge replacement position, follow the instructions on
replacing an ink cartridge in this manual to move it.

2. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.
Parent topic: Solving Problems Printing from a Computer
Related topics
Replacing Ink Cartridges

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
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• If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Make sure the ink drying time has not been increased for double-sided printing.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• High Speed Copies
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

Parent topic: Solving Problems Printing from a Computer
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software
Windows System Requirements
OS X System Requirements
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
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Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - OS X

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software.
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• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows
Related topics
Loading Paper

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
• Make sure you are printing on a compatible borderless paper type and size.

Note: For custom paper sizes, make sure you select a supported borderless page width.

• Windows: Make sure you selected the Borderless setting in your printer software.
• OS X: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in

your printer software.
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• Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems
Related references
Borderless Paper Type Compatibility
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Page Setup Settings - OS X

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If incorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - OS X
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Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Page Setup Settings - OS X

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Alignment
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems
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Related topics
Solving Scanned Image Quality Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Print Head Nozzle Check
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software
Extended Settings - Windows
Related tasks
Selecting Printing Preferences - OS X
Related topics
Loading Paper
Replacing Ink Cartridges

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
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• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel

or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increase Ink Drying Time settings.

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software
Extended Settings - Windows
Paper Specifications
Related tasks
Selecting Printing Preferences - OS X
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Selecting Double-sided Printing Settings - OS X
Selecting Double-sided Printing Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Cleaning the Paper Path
Related topics
Loading Paper
Replacing Ink Cartridges

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Clean the paper path.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Extended Settings - Windows
Related tasks
Selecting Printing Preferences - OS X
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
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Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Extended Settings - Windows
Related tasks
Selecting Printing Preferences - OS X
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
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Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the paper type setting matches the paper you loaded.
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors

may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

• For best results, use genuine Epson ink and paper.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Related references
Extended Settings - Windows
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Managing Color - OS X

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan
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Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).

Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
OS X System Requirements
Related tasks
Scanning with OS X Using Image Capture

Cannot Start Epson Scan
If you cannot start Epson Scan, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• Make sure Epson Scan is selected in your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan.
• Check the connection setting and test the connection using Epson Scan Settings:
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Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the correct
Connection setting is selected, then click the Test button.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the
Test button.
OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

• Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions
and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems
Related tasks
Scanning with OS X Using Image Capture
Related topics
Starting a Scan

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
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Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped
Parent topic: Solving Problems
Related topics
Solving Print Quality Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and

scan again.
Parent topic: Solving Scanned Image Quality Problems
Related references
Available Image Adjustments - Professional Mode
Available Image Adjustments - Home Mode
Available Image Adjustments - Office Mode
Related tasks
Placing Originals on the Scanner Glass

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
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Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the

scanner glass.
• Do not move your original or your product during scanning.
• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable

surface that extends beyond its base in all directions.
• Adjust these Epson Scan settings (if available) and try scanning again:

• Select the Unsharp Mask setting.
• Adjust the Auto Exposure setting.
• Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark
If your scanned image is too dark, try these solutions:
• Adjust these Epson Scan settings (if available) and try scanning again:

• Auto Exposure
• Brightness
• Histogram Adjustment

• Check the brightness and contrast settings of your computer monitor.
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Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting Epson Scan Settings

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.
Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting Epson Scan Settings

Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try
scanning again:
• Change the Image Type setting and experiment with different combinations of the next settings.
• Adjust the Tone Correction setting.
• Adjust the Auto Exposure setting.
Parent topic: Solving Scanned Image Quality Problems
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Related topics
Selecting Epson Scan Settings

Scan Area is Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:
• Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
• Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems
Related concepts
Image Preview Guidelines
Related tasks
Selecting a Scan Size - Professional Mode
Selecting a Scan Area - Office Mode
Selecting a Scan Area - Home Mode

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Solving Memory Card Problems
Check these solutions if you have problems using memory cards with your product.
Memory Card Does Not Fit Into a Slot
Cannot View or Print Photos from a Memory Card
Cannot Transfer Photos To or From a Memory Card
Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot
If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with
your memory card.
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Parent topic: Solving Memory Card Problems
Related references
Memory Card Types
Related tasks
Inserting a Memory Card

Cannot View or Print Photos from a Memory Card
If you cannot view or print photos from a memory card inserted in your product, try these solutions:
• Make sure you have inserted only one memory card at a time.
• Make sure your memory card is compatible with the product.
• Make sure the files on your memory card are in the correct format.
• If you have too many photos on your memory card, you may not see all the photos you expect or may

be prompted to select a group of photos by date. Reduce the number of photos on your card or select
one group of photos at a time. Check the memory card specifications for the maximum number of
photos.

Parent topic: Solving Memory Card Problems
Related references
Memory Card Types
Memory Card File Specifications
Related tasks
Inserting a Memory Card

Cannot Transfer Photos To or From a Memory Card
If you have problems transferring photos to or from a memory card inserted in your product, try these
solutions:
• Make sure you have inserted only one memory card at a time.
• Make sure your memory card is compatible with the product.
• Make sure your product is securely connected to your computer.
• If you are transferring photos to the memory card, check the memory card's write-protect tab to make

sure it is set to allow writing to the card. Also make sure the card has enough memory available.
• Make sure that the file sharing setting for your product is set correctly.
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Parent topic: Solving Memory Card Problems
Related references
Memory Card File Specifications
Memory Card Types
Related topics
Transferring Photos on a Memory Card

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - OS X
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
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4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
• Windows 8.x: Select Epson Event Manager and click Uninstall.
• Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and

Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

• Windows XP: Open the Windows Control Panel utility. Double-click Add or Remove Programs.
Select Epson Event Manager and click Change/Remove.

5. Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:
• Windows 8.x/Windows 7/Windows Vista: Select EPSON Scan and click Uninstall/Change.
• Windows XP: Select EPSON Scan and click Change/Remove.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the Uninstaller icon.
5. Select the checkbox for each software program you want to uninstall.
6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the Start Here sheet for instructions.
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Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).
Parent topic: Solving Problems
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Windows System Requirements
OS X System Requirements
Scanning Specifications
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Memory Card Specifications
External USB Device Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3
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Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed
Photoelectric device CIS
Maximum document size 8.5 × 11.7 inches (216 × 297 mm)

US letter or A4
Scanning resolution 4800 dpi (main scan)

4800 dpi (sub scan)
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Color depth Color:
48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color external)
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black-and-white:
16 bits per pixel internal
1 bit per pixel external

Light source LED

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications
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Printable Area Specifications
Note: Print quality may decline in the shaded areas shown here due to the printer mechanism.

Single sheets - normal printing

1 Margin: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.61 inch (41 mm) minimum
3 Reduced print quality area/bottom: 1.46 inch (37 mm) minimum

Single sheets - borderless printing
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1 Reduced print quality area/top: 1.73 inch (44 mm) minimum
2 Reduced print quality area/bottom: 1.57 inch (40 mm) minimum

Envelopes

1 Left/right margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.20 inch (5 mm) minimum
3 Reduced print quality area/right: 0.71 inch (18 mm) minimum
4 Reduced print quality area/left: 1.61 inch (41 mm) minimum

CD/DVD
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1 Minimum inner margin: 0.71 inch (18 mm)
2 Inner reduced print quality area: 1.69 inch (43 mm)
3 Outer reduced print quality area: 4.57 inch (116 mm)
4 Maximum outer margin: 4.72 inch (120 mm)

Parent topic: Technical Specifications

Ink Cartridge Specifications
Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black, Cyan, Magenta, Yellow, Light Cyan, Light Magenta
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Temperature Storage: –22 to 104 °F (–30 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Memory Card Specifications
Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.
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Compatible types/Maximum Memory Stick Duo: 128MB
capacities Memory Stick PRO Duo: 32GB

Memory Stick PRO-HG Duo: 32GB
MagicGate Memory Stick Duo: 32GB
Memory Stick Micro*: 32GB
miniSD*: 2GB
miniSDHC*: 32GB
microSD*: 2GB
microSDHC*: 32GB
microSDXC*: 64GB
SD: 2GB
SDHC: 32GB
SDXC: 64GB
CompactFlash: 32GB
MicroDrive: 6GB

Voltage requirements 3.3 V type, dual voltage type (3.3 V and 5V); supply voltage 3.3 V
Maximum supply current:
Memory Stick and Memory Stick PRO: 100 mA
SD: 200 mA
CompactFlash and MicroDrive: 500 mA

Parent topic: Technical Specifications

External USB Device Specifications
Do not use devices with the following requirements:
• Dedicated driver
• Security settings, such as password or encryption, etc.
• Built-in USB hub
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Note: Use only external storage devices with independent AC power sources. External storage devices
that are powered via USB are not recommended. Epson cannot guarantee the operation of externally
connected devices.

CD-ROM/CD-R drive 700MB maximum capacity
CD-RW is not supported

DVD-ROM/DVD-R drive 4.7GB maximum capacity
DVD-RW, DVD+R, DVD+RW, DVD-RAM, and Blu-ray Disc are not
supported

Magneto-optical drive 1.3GB
Hard disk and USB flash 2TB
drives Formatted in FAT, FAT32, or exFAT.

Parent topic: Technical Specifications

Dimension Specifications
Height Stored: 5.8 inches (148 mm)

Printing: 11.6 inches (295 mm)
Width Stored: 18.9 inches (479 mm)

Printing: 18.9 inches (479 mm)
Depth Stored: 14.0 inches (356 mm)

Printing: 26.3 inches (668 mm)
Weight 19.2 lb (8.7 kg)
(without ink cartridges, power
cord, and CD/DVD tray)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 120 V
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Rated frequency range 50/60 Hz
Rated current 0.7 A
Power consumption Standalone copying: Approximately 17 W (ISO/IEC24712)
(USB connection) Ready mode: Approximately 8.2 W

Sleep mode: Approximately 1.2 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH
(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
For computer Hi-Speed USB
For external USB and Hi-Speed USB
PictBridge devices

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications
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Network Interface Specifications
Wi-Fi

Standards IEEE 802.11 b/g/n
Security WEP (64/128 bit)

WPA-PSK (AES); complies with WPA2 with support for WPA/WPA2
Personal

Frequency range 2.4 GHz
Coordination modes Infrastructure mode

Ad hoc mode (not supported for IEEE 802.11n)
Wi-Fi Direct (not supported for IEEE 802.11b)

Note: Simple AP mode is compatible with Wi-Fi infrastructure mode
and Ethernet connections.

Ethernet

Standard IEEE802.3i/u (10BASE-T)
IEEE802.3u (100BASE-TX)
IEEE802.3az (Energy Efficient Ethernet; connected device should
be IEEE802.3az compliant)

Communication mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100 Mbps Full
duplex, 100Mbps Half duplex

Connector RJ-45

Security Protocol
SSL/TLS: HTTPS Server/Client, IPPS
Parent topic: Technical Specifications
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Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
• Manufacturer: Askey Computer Corporation.
• Type: WLU6320-D69 (RoHS)
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Product Safety Instructions
Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions
LCD Screen Safety Instructions
Parent topic: Notices

General Product Safety Instructions
• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock.

Do not use the cord with any other equipment.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system

that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,

crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
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ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.
• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not

operate properly if it is tilted or at an angle.
• Allow space behind the product for the cables, and space above the product so that you can fully raise

the document cover.
• Leave enough space in front of the product for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place or store the product outdoors.
• Do not place the product near excessive heat sources or in direct sunlight.
• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers

or the base units of cordless telephones.
• When connecting the product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not touch the flat white cable inside the product.
• Do not move the print head by hand; this may damage the product.
• Do not spill liquid on the product or use the product with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may

cause fire.
• Do not press too hard on the document table when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any

other functions.
• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
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or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

• Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions
• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply

port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges

uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the cartridge; this can cause leakage.
• Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to

become unusable.
• Do not break the hooks on the side of the cartridge when removing it from the packaging.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in

the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
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• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

• Store ink cartridges with their labels facing upward. Do not store cartridges upside down.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
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• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Trademarks
EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
ConnectTM, Epson iPrintTM and Remote PrintTM are trademarks of Seiko Epson Corporation.
Epson StoreSM is a service mark of Epson America, Inc.
Apple, iPad, iPhone, iPod touch, Mac, and OS X are trademarks of Apple Inc., registered in the U.S. and
other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
Google® is a registered trademark and AndroidTM, ChromebookTM, Google ChromeTM, Google Cloud
PrintTM, and PicasaTM are trademarks of Google Inc.
Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices
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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
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Parent topic: Copyright Notice

Copyright Attribution
© 2015 Epson America, Inc.
7/15
CPD-42858
Parent topic: Copyright Notice
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